Applicable Product:

- **Range-free Multi-controller FA-M3**

  The document number and document model code for this manual are given below. Refer to the document number in all communications; also refer to the document number or the document model code when purchasing additional copies of this manual.

- Document No.: IM 34M06Q30-01E
- Document Model Code: DOCIM
### Important

**About This Manual**

- This Manual should be passed on to the end user.
- Before using the controller, read this manual thoroughly to have a clear understanding of the controller.
- This manual explains the functions of this product, but there is no guarantee that they will suit the particular purpose of the user.
- Under absolutely no circumstances may the contents of this manual be transcribed or copied, in part or in whole, without permission.
- The contents of this manual are subject to change without prior notice.
- Every effort has been made to ensure accuracy in the preparation of this manual. However, should any errors or omissions come to the attention of the user, please contact the nearest Yokogawa Electric representative or sales office.

**Symbols Related to Safety**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Danger" /></td>
<td><strong>Danger.</strong> This symbol on the product indicates that the operator must follow the instructions laid out in this user's manual to avoid the risk of personnel injuries, fatalities, or damage to the instrument. Where indicated by this symbol, the manual describes what special care the operator must exercise to prevent electrical shock or other dangers that may result in injury or the loss of life.</td>
</tr>
<tr>
<td><img src="image" alt="Protective Ground Terminal" /></td>
<td><strong>Protective Ground Terminal.</strong> Before using the instrument, be sure to ground this terminal.</td>
</tr>
<tr>
<td><img src="image" alt="Function Ground Terminal" /></td>
<td><strong>Function Ground Terminal.</strong> Before using the instrument, be sure to ground this terminal.</td>
</tr>
<tr>
<td><img src="image" alt="Alternating current" /></td>
<td><strong>Alternating current.</strong> Indicates alternating current.</td>
</tr>
<tr>
<td><img src="image" alt="Direct current" /></td>
<td><strong>Direct current.</strong> Indicates direct current.</td>
</tr>
</tbody>
</table>
The following symbols are used only in the user's manual.

⚠️ **WARNING**
- Indicates a “Warning”.
- Draws attention to information essential to prevent hardware damage, software damage or system failure.

⚠️ **CAUTION**
- Indicates a “Caution”.
- Draws attention to information essential to the understanding of operation and functions.

💡 **TIP**
- Indicates a “TIP”.
- Gives information that complements the present topic.

**SEE ALSO**
- Indicates a “SEE ALSO” reference.
- Identifies a source to which to refer.

### Safety Precautions when Using/Maintaining the Product

- For the protection and safe use of the product and the system controlled by it, be sure to follow the instructions and precautions on safety stated in this manual whenever handling the product. Take special note that if you handle the product in a manner other than prescribed in these instructions, the protection feature of the product may be damaged or impaired. In such cases, Yokogawa cannot guarantee the quality, performance, function and safety of the product.

- When installing protection and/or safety circuits such as lightning protection devices and equipment for the product and control system as well as designing or installing separate protection and/or safety circuits for fool-proof design and fail-safe design of processes and lines using the product and the system controlled by it, the user should implement it using devices and equipment, additional to this product.

- If component parts or consumable are to be replaced, be sure to use parts specified by the company.

- This product is not designed or manufactured to be used in critical applications which directly affect or threaten human lives and safety — such as nuclear power equipment, devices using radioactivity, railway facilities, aviation equipment, shipboard equipment, aviation facilities or medical equipment. If so used, it is the user’s responsibility to include in the system additional equipment and devices that ensure personnel safety.

- Do not attempt to modify the product.

- In order to prevent electrical shock, turn off all the power sources before connecting wires, etc.

- This product is classified as Class A for use in industrial environments. If used in a residential environment, it may cause electromagnetic interference (EMI). In such situations, it is the user’s responsibility to adopt the necessary measures against EMI.
Exemption from Responsibility

- Yokogawa Electric Corporation (hereinafter simply referred to as Yokogawa Electric) makes no warranties regarding the product except those stated in the WARRANTY that is provided separately.

- Yokogawa Electric assumes no liability to any party for any loss or damage, direct or indirect, caused by the use or any unpredictable defect of the product.

Software Supplied by the Company

- Yokogawa Electric makes no other warranties expressed or implied except as provided in its warranty clause for software supplied by the company.

- Use the software with one computer only.

- You must purchase another copy of the software for use with each additional computer.

- Copying the software for any purposes other than backup is strictly prohibited.

- Store the original media that contain the software in a safe place.

- Reverse engineering, such as decompiling of the software, is strictly prohibited.

- Under absolutely no circumstances may the software supplied by Yokogawa Electric be transferred, exchanged, or sublet or leased, in part or as a whole, for use by any third party without prior permission by Yokogawa Electric.
General Requirements for Using the FA-M3 Controller

- Set the product in a location that fulfills the following requirements:
  - Where the product will not be exposed to direct sunlight, and where the operating surrounding air temperature is from 0°C to 55°C (32°F to 131°F).
    There are modules that must be used in an environment where the operating surrounding air temperature is in a range smaller than 0°C to 55°C (32°F to 131°F). Refer to hardware user’s manual or the applicable user’s manual. In case of attaching such a module, the entire system’s operating surrounding air temperature is limited to the module’s individual operating surrounding air temperature.
  - Where the relative humidity is from 10 to 90%.
    In places where there is a chance of condensation, use a space heater or the like to constantly keep the product warm and prevent condensation.
  - For use in Pollution Degree 2 Environment.
  - Where there are no corrosive or flammable gases.
  - Where the product will not be exposed to mechanical vibration or shock that exceed specifications.
  - Where there is no chance the product may be exposed to radioactivity.

- Use the correct types of wire for external wiring:
  - USE COPPER CONDUCTORS ONLY.
  - Use conductors with temperature ratings greater than 75°C.

- Securely tighten screws:
  - Securely tighten module mounting screws and terminal screws to avoid problems such as faulty operation.
  - Tighten terminal block screws with the correct tightening torque. Refer to the hardware user’s manual or the applicable user’s manual for the appropriate tightening torque.

- Securely lock connecting cables:
  - Securely lock the connectors of cables, and check them thoroughly before turning on the power.

- Interlock with emergency-stop circuitry using external relays:
  - Equipment incorporating the FA-M3 controller must be furnished with emergency-stop circuitry that uses external relays. This circuitry should be set up to interlock correctly with controller status (stop/run).

- Ground for low impedance:
  - For safety reasons, connect the [FG] grounding terminal to a Japanese Industrial Standards (JIS) Class D (earlier called Class 3) Ground. For compliance to CE Marking, use braided or other wires that can ensure low impedance even at high frequencies for grounding.

*1 Japanese Industrial Standard (JIS) Class D Ground means grounding resistance of 100 Ω max.
Configure and route cables with noise control considerations:
- Perform installation and wiring that segregates system parts that may likely become noise sources and system parts that are susceptible to noise. Segregation can be achieved by measures such as segregating by distance, installing a filter or segregating the grounding system.

Configure for CE Marking Conformance:
- For compliance with CE Marking, perform installation and cable routing according to the description on compliance to CE Marking in the “Hardware Manual”.

We recommend that you stock up on maintenance parts:
- We recommend that you stock up on maintenance parts, including spare modules, in advance.
- Preventive maintenance (replacement of the module) is required for using the module beyond 10 years.

Discharge static electricity before touching the system:
- Because static charge can accumulate in dry conditions, first touch grounded metal to discharge any static electricity before touching the system.

Wipe off dirt with a soft cloth:
- Gently wipe off dirt on the product’s surfaces with a soft cloth.
- If you soak the cloth in water or a neutral detergent, tightly wring it out before wiping the product.
  Letting water enter the module interior can cause malfunctions.
- Do not use volatile solvents such as benzine or paint thinner or chemicals for cleaning, as they may cause deformity, discoloration, or malfunctioning.

Avoid storing the FA-M3 controller in places with high temperature or humidity:
- Since the CPU module has a built-in battery, avoid storage in places with high temperature or humidity.
- Since the service life of the battery is drastically reduced by exposure to high temperatures, take special care (storage surrounding air temperature should be from \(-20^\circ\text{C}\) to \(75^\circ\text{C}\)).
- There is a built-in lithium battery in a CPU module which serves as backup power supply for programs, device information and configuration information. The service life of this battery is more than 10 years in standby mode at room temperature. Take note that the service life of the battery may be shortened when installed or stored at locations of extreme low or high temperatures. Therefore, we recommend that modules with built-in batteries be stored at room temperature.

Always turn off the power before installing or removing modules:
- Failing to turn off the power supply when installing or removing modules, may result in damage.
★ Do not touch components in the module:
- In some modules you can remove the right-side cover and install ROM packs or change switch settings. While doing this, do not touch any components on the printed-circuit board, otherwise components may be damaged and modules may fail to work.

★ Do not use unused terminals:
- Do not connect wires to unused terminals on a terminal block or in a connector. Doing so may adversely affect the functions of the module.

★ Use the following power source:
- Use only power supply module F3PU□□-□□□ in FA-M3 Controller for supplying power input for control circuit connection.
- If using this product as a UL-approved product, for the external power supply, use a limited voltage / current circuit power source or a Class 2 power source.

★ Refer to the user’s manual before connecting wires:
- Refer to the hardware user’s manual or the applicable user’s manual for the external wiring drawing.
- Refer to “A3.6.5 Connecting Output Devices” in the hardware user’s manual before connecting the wiring for the output signal.
- Refer to “A3.5.4 Grounding Procedure” in the hardware user’s manual for attaching the grounding wiring.
Waste Electrical and Electronic Equipment

Waste Electrical and Electronic Equipment (WEEE), Directive 2002/96/EC
(This directive is only valid in the EU.)

This product complies with the WEEE Directive (2002/96/EC) marking requirement. The following marking indicates that you must not discard this electrical/electronic product in domestic household waste.

Product Category
With reference to the equipment types in the WEEE directive Annex 1, this product is classified as a “Monitoring and Control instrumentation” product.
Do not dispose in domestic household waste.
When disposing products in the EU, contact your local Yokogawa Europe B. V. office.

How to Discard Batteries

The following description on DIRECTIVE 2006/66/EC (hereinafter referred to as the EU new directive on batteries) is valid only in the European Union.

Some models of this product contain batteries that cannot be removed by the user. Make sure to dispose of the batteries along with the product.

Do not dispose in domestic household waste.
When disposing products in the EU, contact your local Yokogawa Europe B. V. office.

Battery type: Lithium battery

Note: The symbol above means that the battery must be collected separately as specified in Annex II of the EU new directive on batteries.
Introduction

■ Overview of This Manual

This manual is the operation manual for ToolBox, a tool for performing setup and controlling advanced function modules of the Range-free Multi-controller FA-M3. It describes basic methods for using ToolBox to set up registered parameters, as well as to test, monitor and debug module actions.

For enquiries, please contact the store where you purchased the product or the nearest Yokogawa sales office listed at the back of this manual. Where required, you should also read the relevant computer manual or printer manual.

Advanced function modules as described in this manual refer to special FA-M3 modules with special functions, such as temperature control and monitoring modules, or positioning modules. CPU modules, input/output modules and power supply modules are not considered advanced function modules.

■ Structure of the Manual

This manual consists of three parts: A, B and C.

• Part A Startup Manual

Part A covers required user operations for using ToolBox, and describes how to install the software, how to use the online manual and how to connect to the FA-M3, etc.

• Part B Operation Manual

Part B describes how to create data for registered parameters and run advanced function modules. In data creation, we use software to set up the function and action of individual advanced function modules. In execution, we use the created data to run the module to perform tuning and adjustment.

• Part C Reference Guide

Part C describes the various warning messages of ToolBox, the restrictions when using ToolBox, as well as the content of the ToolBox menu bar.
# How to Read This Manual

Be sure to read the “Introduction”, “How to Read This Manual”, as well as this manual before using ToolBox.

This manual is structured so that each chapter or section in Part A and Part B can be read independently to understand the basic specifications of ToolBox.

We have, in our design, made the basic user interface, operations and editing functions of the ToolBox application as similar as possible to other generally available Windows software. This manual does not, thus, contain information on general Windows editing operations, which are not specific to ToolBox.

This manual describes the standard functions of ToolBox. For details on the setup and use of an individual advanced function module, please refer to the manual of the setup tool dedicated for the advanced function module.

# Notation

- **Notation for Windows Screens and Operations**
  
  Items in initial caps denote symbols, proper names and window names.
  
  Example: ToolBox, Local Device

  Bracketed items denote menu bar items, dialog box fields, commands and buttons.
  
  Example: Select [File]-[New] from the menu bar. This means to click [File] on the menu bar, followed by [New] on the pull-down menu.

- **Representations in ToolBox Figures and Screens**

  The screen examples given in this manual essentially assumes a Windows XP operating environment.

  Icons and application names may differ in other windows operating environments such as Windows 2000, Windows Vista and Windows 7.

  Some figures in this manual may, for reasons of convenience, be emphasized or simplified, or parts of it may be omitted. Some screen images in this manual may differ from actual screens due to differences in the operating machine environment.

- **Function Keys and Shortcut Keys**

  In addition to using a mouse, you can operate ToolBox menus using function keys and shortcut keys.

  In general, this manual describes operations using a mouse.
Other Instruction Manuals

For individual sequence CPU modules, please refer to the relevant instruction manuals. These manuals are available separately.

- For information on functions of sequence CPU modules, refer to:

<table>
<thead>
<tr>
<th>Document Name</th>
<th>Document Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence CPU – Functions (for F3SP28-3N/3S, F3SP38-6N/6S, F3SP53-4H/4S, F3SP58-6H/6S, F3SP59-7S)</td>
<td>IM34M06P13-01E</td>
</tr>
<tr>
<td>Sequence CPU – Functions (for F3SP66-4S, F3SP67-6S)</td>
<td>IM34M06P14-01E</td>
</tr>
<tr>
<td>Sequence CPU – Network Functions (for F3SP66-4S, F3SP67-6S)</td>
<td>IM34M06P14-02E</td>
</tr>
<tr>
<td>Sequence CPU – Functions (for F3SP71-4N/4S, F3SP76-7N/7S)</td>
<td>IM34M06P15-01E</td>
</tr>
<tr>
<td>Sequence CPU – Network Functions (for F3SP71-4N/4S, F3SP76-7N/7S)</td>
<td>IM34M06P15-02E</td>
</tr>
<tr>
<td>Sequence CPU – Functions (for F3SP21, F3SP25 and F3SP35)</td>
<td>IM34M06P12-02E</td>
</tr>
</tbody>
</table>

- For information on instructions of sequence CPU modules, refer to:

<table>
<thead>
<tr>
<th>Document Name</th>
<th>Document Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence CPU – Instructions</td>
<td>IM34M06P12-03E</td>
</tr>
</tbody>
</table>

- For the FA-M3 specifications and configurations*, installation and wiring, test run, maintenance, and module installation limits for the whole system:

*1: Refer to the relevant product manuals for specifications except for power supply modules, base modules, input/output modules, cables, and terminal units.

<table>
<thead>
<tr>
<th>Document Name</th>
<th>Document Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware Manual</td>
<td>IM34M06C11-01E</td>
</tr>
</tbody>
</table>
Copyrights and Trademarks

■ Copyrights

Copyrights of the programs and online manual included in this CD-ROM belong to Yokogawa Electric Corporation.

This online manual may be printed but PDF security settings have been made to prevent alteration of its contents.

This online manual may only be printed and used for the sole purpose of operating this product. When using a printed copy of the online manual, pay attention to possible inconsistencies with the latest version of the online manual. Ensure that the edition agrees with the latest CD-ROM version.

Copying, passing, selling or distribution (including transferring over computer networks) of the contents of the online manual, in part or in whole, to any third party, is strictly prohibited. Registering or recording onto videotapes and other media is also prohibited without expressed permission of Yokogawa Electric Corporation.

■ Trademarks

- Microsoft and Windows are registered trademarks of Microsoft Corporation, USA.
- The trade and company names that are referred to in this document are either trademarks or registered trademarks of their respective companies.
CONTENTS

Applicable Product .............................................................................................................. i
Important ................................................................................................................................ ii
Introduction ........................................................................................................................... ix
Copyrights and Trademarks ................................................................................................. xii

Part A  Startup Manual

A1  Product Overview ........................................................................................................ A1-1
A1.1  Overview and Features .............................................................................................. A1-1
A1.2  New and Updated Functions .................................................................................... A1-3
   A1.2.1  Differences between ToolBox R2 and ToolBox R1 ............................................. A1-3
   A1.2.2  Differences between ToolBox R3 and ToolBox R2 ............................................ A1-4
   A1.2.3  Differences between ToolBox R4 and ToolBox R3 ............................................ A1-5
   A1.2.4  Differences between ToolBox R5 and ToolBox R4 ............................................ A1-6
   A1.2.5  Differences between ToolBox R6 and ToolBox R5 ............................................ A1-7

A2  Preparing ToolBox ....................................................................................................... A2-1
A2.1  Procedure for Using ToolBox .................................................................................. A2-1
A2.2  Operating Environment for ToolBox ...................................................................... A2-2
A2.3  Installing and Uninstalling ToolBox ...................................................................... A2-3
   A2.3.1  Installing ToolBox .......................................................................................... A2-3
   A2.3.2  Uninstalling ToolBox ..................................................................................... A2-6
   A2.3.3  Installing USB Driver .................................................................................... A2-8
A2.4  Starting and Terminating ToolBox .......................................................................... A2-11
A2.5  Functions Available in ToolBox ............................................................................. A2-12
A2.6  Connecting ToolBox and FA-M3 System ................................................................ A2-13

Part B  Operation Manual

B1  Using ToolBox .............................................................................................................. B1-1
B1.1  ToolBox Operation Screen ...................................................................................... B1-1
   B1.1.1  Screen Layout ................................................................................................. B1-1
B1.2  Menu Layout and Command List ............................................................................ B1-6
B1.3  ToolBox Operation Commands .............................................................................. B1-7
   B1.3.1  Basic Keys ...................................................................................................... B1-7
   B1.3.2  Shortcut Keys ................................................................................................ B1-8
B1.4  Configuring ToolBox ............................................................................................... B1-9
   B1.4.1  Folder Structure ............................................................................................ B1-9
   B1.4.2  Environment Setup ........................................................................................ B1-11
B2 Creating Projects ................................................................. B2-1
  B2.2 Creating New Projects .................................................... B2-3
    B2.2.1 Starting ToolBox ......................................................... B2-3
    B2.2.2 Selecting a CPU Module .............................................. B2-3
    B2.2.3 Creating and Editing Registered Parameters .................. B2-4
  B2.3 Modifying Existing Projects ........................................... B2-5
    B2.3.1 Opening a Project ..................................................... B2-5
    B2.3.2 Modifying a Project ................................................... B2-6

B3 Setting up Connections and Connecting to FA-M3 .............. B3-1
  B3.1 Communications Setup ................................................. B3-1
  B3.2 Connecting and Disconnecting ....................................... B3-5
    B3.2.1 Direct Connection .................................................... B3-5
    B3.2.2 Disconnecting .......................................................... B3-19
    B3.2.3 Temporarily Changing Communication Speed .................. B3-20
    B3.2.4 Local Node Setup .................................................... B3-21
  B3.3 FA-M3 System Configuration Setup ................................... B3-23
    B3.3.1 System Configuration Setup ....................................... B3-23
    B3.3.2 When the FA-M3 Installation Configuration is Changed .... B3-24
  B3.4 FA-M3 Communication Server ......................................... B3-25
    B3.4.1 Specifications ......................................................... B3-25
    B3.4.2 System Tray Icon and Operations ................................ B3-26
    B3.4.3 Detailed Setting Screen ............................................. B3-26
    B3.4.4 Communications Setup for Each Port ............................. B3-28
    B3.4.5 Forced Termination ................................................... B3-29

B4 Downloading Registered Parameters .................................. B4-1
  B4.1 Downloading ............................................................... B4-1
    B4.1.1 Downloading to Individual Modules .............................. B4-2
    B4.1.2 Downloading a Project .............................................. B4-6
  B4.2 Verifying Downloaded Registered Parameters .................... B4-8
    B4.2.1 Verifying Module Data .............................................. B4-9
    B4.2.2 Verifying Project Data .............................................. B4-13
    B4.2.3 If Messages are Displayed During Comparison ............... B4-15

B5 Adjusting and Checking Online Registered Parameters ....... B5-1
  B5.1 Adjusting Registered Parameters Using Action Test ............ B5-2
  B5.2 Checking Action Status Using Action Monitor .................... B5-4
  B5.3 Monitoring I/O Relays .................................................... B5-5

B6 Uploading Registered Parameters to Computer .................... B6-1
  B6.1 Uploading Registered Parameters ..................................... B6-1
    B6.1.1 Uploading from Individual Modules .............................. B6-2
    B6.1.2 Uploading a Project ................................................ B6-6
    B6.1.3 Saving Uploaded Data .............................................. B6-7
  B6.2 Writing Registered Parameters to ROM ............................ B6-9
Part C  Reference Guide

C1  Useful Technical Information

C1.1  Warnings

C1.2  Handling for Special Cases
  C1.2.1  Downloading
  C1.2.2  ROM Transfer
  C1.2.3  ROM Initialization

C1.3  Limitations
  C1.3.1  Limitations of ToolBox
  C1.3.2  Limitations Across Modules

C1.4  Menu Bar Overview
  C1.4.1  Menu Description

Index

Revision Information
A1  Product Overview

This chapter gives a product overview of ToolBox and describes its key features.

A1.1  Overview and Features

Overview

ToolBox is a software application that runs in the Microsoft Windows environment. It provides an environment for setting and adjusting internal parameters of FA-M3 advanced function modules. The FA-M3 and PC must be connected via USB (or RS-232C for some CPU types), Ethernet or other communications means before parameters setup and adjustment.

ToolBox provides individual setup tools for various advanced function modules, each with different functions. Having individual setup tool components for various advanced function modules allow these components to be run concurrently on a common ToolBox platform.

Advanced function modules refer to modules that use extended functions of the FA-M3, and do not include basic modules like the CPU modules, power supply modules and I/O modules.

CAUTION

ToolBox is a parameter setup tool for FA-M3 advanced function modules, and its control functions and operation functions are not intended for continuous operations in a production environment.
Features

The ToolBox software has the following features.

- **Compatibility with Other Applications**
  - It can be run concurrently with the FA-M3 Ladder Program Development Tool WideField3 to perform concurrent editing, communications, etc.
  - It can be run concurrently with auxiliary tools (Sampling trace, data management tools, etc.) of the FA-M3 Ladder Program Development Tool WideField3 to perform concurrent communications, etc.

**CAUTION**

When using WideField3 and ToolBox concurrently for the same FA-M3, depending on the operations performed, delayed online operations or temporary pauses may occur due to heavy communications load.

- **Communications Protocol**
  USB, RS-232C (CPU direct, or via modem), Ethernet and FL-net communications are supported.

**TIP**

- Depending on the chipset used in the PC, USB connection may sometimes be unreliable. The USB connection function is not guaranteed to work with all PCs (chipsets).
- A USB connection may become unreliable or even disconnected due to noise. If this happens, remove and re-attach the USB cable to the PC.
A1.2 New and Updated Functions

A1.2.1 Differences between ToolBox R2 and ToolBox R1

This subsection describes differences in functions between ToolBox R2 and ToolBox R1. There is only a Japanese version and no English version for ToolBox R2.

**SEE ALSO**

For details of individual functional differences, see sections given in the “See Also” column in Table A1.1.

**TIP**

To confirm the software version of ToolBox R2, select [Help]-[About ToolBox] from the menu bar. A dialog box as shown below appears (the screen capture will be in Japanese as there is no English version for ToolBox R2). Verify that the version is displayed as “R2.xx”. The version of ToolBox is determined by the revision of the module installed.

**Table A1.1 New and Updated Functions in ToolBox R2**

<table>
<thead>
<tr>
<th>Category</th>
<th>Function Details</th>
<th>Summary</th>
<th>See Also</th>
</tr>
</thead>
<tbody>
<tr>
<td>New functions in R2</td>
<td>FL-net communications</td>
<td>Allows connection of ToolBox to FA-M3 using FL-net, with support of all the same functions available when connected using other communications medium.</td>
<td>A2.2 Operating Environment for ToolBox A2.6 Connecting ToolBox and FA-M3 System B3.1 Communications Setup B3.2 Connecting and Disconnecting</td>
</tr>
<tr>
<td></td>
<td>Temporarily Change Communication Speed</td>
<td>Allows a user to temporarily change the transmission rate to the communication port of the CPU module when connecting to the FA-M3 using RS-232C.</td>
<td>B3.2.3 Temporarily Changing Communication Speed</td>
</tr>
</tbody>
</table>

**CAUTION**

When migrating from ToolBox R1 to R2, beware that a registered parameter file opened in ToolBox for Temperature Control and Monitoring Modules R2 will become unusable in ToolBox for Temperature Control and Monitoring Modules R1.
A1.2.2 Differences between ToolBox R3 and ToolBox R2

This subsection describes differences in functions between ToolBox R3 and ToolBox R2.

**SEE ALSO**

For details of individual functional differences, see sections given in the "See Also" column in Table A1.2.

**TIP**

To confirm the software version of ToolBox R3, select [Help]-[About ToolBox] from the menu bar. A dialog box as shown below appears. Verify that the version is displayed as "R3.xx". The version of ToolBox is determined by the revision of the module installed.

![About ToolBox dialog box](image)

<table>
<thead>
<tr>
<th>Category</th>
<th>Function Details</th>
<th>Summary</th>
<th>See Also</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Cut/Delete</td>
<td>Cuts or deletes the content of the selection on an edit screen.</td>
<td>B1.2 Menu Layout and Command List C1.4 Menu Bar Overview</td>
</tr>
<tr>
<td>Online</td>
<td>X/Y I/O Relay Monitor</td>
<td>Monitors input/output (X/Y) relays of the CPU module.</td>
<td>B1.2 Menu Layout and Command List C1.4 Menu Bar Overview</td>
</tr>
<tr>
<td></td>
<td>Destination</td>
<td>Allows a user to specify a destination when connecting using Ethernet or FL-net.</td>
<td>B3.2.1 Direct Connection</td>
</tr>
<tr>
<td>Tools</td>
<td>Environment Setup for ToolBox</td>
<td>[Connect] button added.</td>
<td>B1.4.2 Environment Setup B3.1 Communications Setup</td>
</tr>
</tbody>
</table>
A1.2.3 Differences between ToolBox R4 and ToolBox R3

This subsection describes differences in functions between ToolBox R4 and ToolBox R3

SEE ALSO

For details of individual functional differences, see sections given in the “See Also” column in Table A1.3.

TIP

To confirm the software version of ToolBox R4, select [Help]-[About ToolBox] from the menu bar. A dialog box as shown below appears. Verify that the version is displayed as “R4.xx”. The version of ToolBox is determined by the revision of the module installed.

Table A1.3 New and Updated Functions in ToolBox R4

<table>
<thead>
<tr>
<th>Category</th>
<th>Function Details</th>
<th>Summary</th>
<th>See Also</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online</td>
<td>USB communication</td>
<td>Allows connection of ToolBox to FA-M3 using USB, with support of all the same functions available when connected using other communications medium.</td>
<td>B3.2.1 Direct Connection</td>
</tr>
</tbody>
</table>
A1.2.4 Differences between ToolBox R5 and ToolBox R4

This subsection describes differences in functions between ToolBox R5 and ToolBox R4.

SEE ALSO

For details of individual functional differences, see sections given in the “See Also” column in Table A1.4.

TIP

To confirm the software version of ToolBox R5, select [Help]-[About ToolBox] from the menu bar. A dialog box as shown below appears. Verify that the version is displayed as “R5.xx”. The version of ToolBox is determined by the revision of the module installed.

Table A1.4 New and Updated Functions in ToolBox R5

<table>
<thead>
<tr>
<th>Category</th>
<th>Function Details</th>
<th>Summary</th>
<th>See Also</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Addition of sequence CPU modules</td>
<td>The following sequence CPU modules are added:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- F3SP71-4N</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- F3SP76-7N</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- F3SP22-0S</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>And, functions specific to the additional modules are supported.</td>
<td></td>
</tr>
<tr>
<td>Operating environment</td>
<td>Windows 7 support</td>
<td>Windows 7 support is included in the operating environment.</td>
<td></td>
</tr>
<tr>
<td>Online</td>
<td>Multiple port connections</td>
<td>Allows for simultaneous operation of multiple ToolBox applications connected online to FA-M3 CPU modules.</td>
<td></td>
</tr>
</tbody>
</table>
### A1.2.5 Differences between ToolBox R6 and ToolBox R5

This subsection describes differences in functions between ToolBox R6 and ToolBox R5.

**SEE ALSO**

For details of individual functional differences, see sections given in the “See Also” column in Table A1.5.

**TIP**

To confirm the software version of ToolBox R6, select [Help]-[About ToolBox] from the menu bar. A dialog box as shown below appears. Verify that the version is displayed as “R6.xx”. The version of ToolBox is determined by the revision of the module installed.

---

#### Table A1.5 New and Updated Functions in ToolBox R5

<table>
<thead>
<tr>
<th>Category</th>
<th>Function Details</th>
<th>Summary</th>
<th>See Also</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ToolBoxR6.01</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Entire functions</td>
<td>Language selection</td>
<td>Allows you to select the language mode of Toolbox.</td>
<td></td>
</tr>
<tr>
<td><strong>CPU</strong></td>
<td>Addition of sequence CPU modules</td>
<td>The following sequence CPU modules are added:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- F3SP71-4S</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- F3SP76-7S</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>And, functions specific to the additional modules are supported.</td>
<td></td>
</tr>
<tr>
<td><strong>ToolBoxR6.02</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating environment</td>
<td>Windows Vista(64bit), Windows 7(64bit) support</td>
<td>Windows Vista (64bit) and Windows 7 (64bit) support is included in the operating environment.</td>
<td></td>
</tr>
</tbody>
</table>
A2 Preparing ToolBox

This chapter describes how to install, start and stop ToolBox.

- Procedure for Using ToolBox → A2.1
- Operating Environment for ToolBox → A2.2
- Installing and Uninstalling ToolBox → A2.3
- Starting and Terminating ToolBox → A2.4
- Functions Available in ToolBox → A2.5
- Connecting ToolBox and FA-M3 System → A2.6

A2.1 Procedure for Using ToolBox

- Install ToolBox A2-3
  - Install the program.
- Start ToolBox A2-11
  - Start ToolBox.
- Create a project B2-1
  - Create a project and set up configuration information for subsequent downloading to FA-M3, etc.
- Set up connections and connect to FA-M3 B3-1
  - Perform communications setup and online connection to FA-M3.
  - This also allows retrieval of the system configuration from FA-M3.
- Download registered parameters B4-1
  - Transmit created data to FA-M3.
- Verify FA-M3 data B4-8
  - Validate transmitted data.
- Perform online adjustment of registered parameters B5-1
  - Modify values of registered parameters to achieve the desired operation.
# Operating Environment

This section describes the operating environment for ToolBox.

## Table A2.1  Operating Environment for ToolBox

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC</td>
<td>PC/AT compatible</td>
</tr>
<tr>
<td>Operating System*1</td>
<td>Microsoft® Windows® 7(32bit/64bit)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Vista(32bit/64bit)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 2000 Professional</td>
</tr>
<tr>
<td>Required Software</td>
<td>Internet Explorer 5.01 or higher</td>
</tr>
<tr>
<td>CPU*2</td>
<td>Pentium 133MHz or faster, adequate for the operating system to run properly.</td>
</tr>
<tr>
<td>Memory*3</td>
<td>32MB or more, adequate for the operating system to run properly.</td>
</tr>
<tr>
<td>Hard Disk Capacity</td>
<td>200MB or more available</td>
</tr>
<tr>
<td>Display</td>
<td>800×600 dots or more (1024×768 recommended)</td>
</tr>
<tr>
<td>Communications<em>4</em>5</td>
<td>USB, RS-232C, Ethernet, FL-net</td>
</tr>
<tr>
<td>Printer</td>
<td>Any printer compatible with the operating systems listed above and supports A4</td>
</tr>
<tr>
<td></td>
<td>printing</td>
</tr>
<tr>
<td>Compatible CPU Modules</td>
<td>F3SP05-0P, F3SP08-0P, F3SP08-SP, F3SP21-0N, F3SP25-2N, F3SP35-2N,</td>
</tr>
<tr>
<td></td>
<td>F3SP28-3N, F3SP38-6N, F3SP53-4H, F3SP58-6H, F3SP22-0S, F3SP28-3S, F3SP38-6S,</td>
</tr>
<tr>
<td></td>
<td>F3SP53-4S, F3SP58-6S, F3SP59-7S, F3SPV3-4H, F3SPV8-6H, F3FP36-3N, F3SP66-4S,</td>
</tr>
<tr>
<td></td>
<td>F3SP67-6S, F3SP71-4N, F3SP76-7N, F3SP71-4S, F3SP76-7S</td>
</tr>
</tbody>
</table>

*1: ToolBox only supports the 32-bit (x86) version but not the 64-bit (x64) version of the Windows XP operating system.

*2: For FL-net communications, CPU speed must be Pentium III 750 MHz or higher.

*3: For FL-net communications, memory must be 128MB or more.

*4: For FL-net communications, network card must support TCP/IP protocol.

*5: Depending on the chipset used by the PC running the ToolBox software, reliable USB connection is not always guaranteed.
A2.3  Installing and Uninstalling ToolBox

A2.3.1  Installing ToolBox

This section describes how to install ToolBox. Check the following precautions before installation.

⚠️ CAUTION

Log in with system administrator (Administrator) privileges before performing ToolBox setup, maintenance or deletion as these ToolBox operations cannot be performed by a user without Administrator privileges.

In addition, select [Run as administrator] when executing the installer program in Windows Vista/Windows 7. Installation cannot proceed without Administrator privileges.

⚠️ CAUTION

In Windows Vista/Windows 7, if UAC is enabled, the installer program in the product CD-ROM may be blocked, and cannot be automatically executed.

In this case, select "Setup.exe" in the CD-ROM using Explorer or some other means and start the installer using [Run as administrator].

TIP

The details of the installation procedure may depend on the OS. We describe here how to set up on Windows XP as an example.

1. Insert the ToolBox CD-ROM into the CD-ROM drive of the computer where ToolBox is to be installed.

⇒ The installer program starts automatically and screen 4 is displayed.

Proceed to step 5.

If screen 4 is not displayed, proceed to step 2.

TIP

In Windows Vista/Windows 7, select [Run as administrator] to execute the installer program.

2. From the [Start] menu, click [Programs]-[Accessories]-[Windows Explorer] to start the Windows Explorer software.
3. Double-click the CD-ROM icon.

4. Run "Setup.exe" in the file list.
   ⇒ The Choose Setup Language dialog box is displayed.

5. Select the language to use after installation, and click [Next].

6. Click [Next].
   ⇒ The License Agreement dialog box is displayed.

7. Select [I accept the terms of license agreement], and click [Next].
   ⇒ The Customer Information dialog box is displayed.
8. Enter the user name, company name, and also the serial key (CD-Key) given on the CD-ROM and click [Next].
⇒ The Choose Destination Location dialog box is displayed.

TIP
If another component of ToolBox is already installed on the PC, you need to only add the new component to the existing ToolBox installation. In this case, the installation destination folder is automatically selected.

9. Select the installation destination, and click [Next].
⇒ The Ready to Install the Program dialog box is displayed.

10. Click [Install].
⇒ The installation of ToolBox starts.

11. When the installation is completed, the ToolBox setup completed successfully screen is displayed. Click [Finish] to end the setup.
A2.3.2 Uninstalling ToolBox

1. Insert the ToolBox CD-ROM into the CD-ROM drive of the computer where ToolBox is installed.
   ⇒ The installer program starts automatically and screen (8) is displayed. If the screen is not displayed, run "Setup.exe" using Explorer or some other means.

   **TIP**
   In Windows Vista/Windows 7, select [Run as administrator] to execute the installer program.

   **TIP**
   You can uninstall ToolBox using “Add/Remove Programs” icon in the windows control panel.

2. Select [Remove], and click [Next].
   ⇒ The Confirm Uninstall dialog box is displayed.

   **TIP**
   If you select another option than [Remove], the installer program executes one of the following operations depending on the selected option.
   [Modify]: Allows you to change the installation settings and performs the setup again.
   [Repair]: Reinstalls all components. In addition, you can select [Repair] to update ToolBox.

3. Click [OK].
   ⇒ The uninstallation of ToolBox starts.

**TIP**

If an uninstall operation deletes all components installed in the ToolBox on the PC, the following ToolBox Cleanup dialog box will be displayed to confirm if you wish to delete ToolBox files on the PC, which are now made redundant.

The ToolBox Cleanup function deletes all redundant ToolBox system files, registry information and sample data. However, it does not delete data files such as parameter files and log files created using ToolBox.
A2.3.3 Installing USB Driver

This section describes how to install the USB driver software.

- For Windows 2000, XP, Vista

⚠️ CAUTION

The USB driver software is installed when the PC detects a sequence CPU with USB support.

1. Connect the sequence CPU with USB support to the PC using a USB cable.⇒ The Found New Hardware wizard is displayed.

2. Select [Install from a list or specific location (Advanced)], and click Next.⇒ The “Please choose your search and installation options” dialog of the Found New Hardware wizard is displayed.

3. Select [Search for the best driver in these locations], turn on the [Include this location in the search] checkbox.

4. Specify the "<ToolBox installed folder>\Driver" folder using the Browse button or by direct input. Click Next.⇒ Installation of the USB driver begins.

5. Click Finish to exit from installation.

⚠️ CAUTION

Do not connect the same PC to two or more FA-M3 units using USB cables as only the first connected USB port can be used.

The USB driver of the second and subsequent connected USB ports will not be correctly detected. To rectify the problem, remove and reattach the USB cable.
For Windows 7

CAUTION

To install a USB driver in Windows 7, use the installer provided with the product.

◆ Procedure ◆

(1) Open the "\Driver\UsbDriver\x86" folder on the CD-ROM using Explorer or some other means.

TIP
During driver installation, a dialog box will be displayed to confirm upgrading to Administrator privileges. Select a suitable operation on the dialog box and continue the installation.

%Program Files%\Common Files\yokogawa\Driver\x86 Folder is also available instead of CD-ROM.

Select x86 folder and x64 folder for 32 bit OS and 64 bit OS, respectively.

(2) Run "dpinst.exe" as administrator.
⇒ The FA-M3 USB Driver Setup dialog box is displayed.

(3) Click [Next]. The USB driver installation is automatically started.
⇒ An installation confirmation message is displayed.

**TIP**
Check that the status shows "Ready to use" on the message dialog box.

---

**CAUTION**
Do not connect the same PC to two or more FA-M3 units using USB cables as only the first connected USB port can be used.
The USB driver of the second and subsequent connected USB ports will not be correctly detected. To rectify the problem, remove and reattach the USB cable.
## A2.4 Starting and Terminating ToolBox

### Starting ToolBox

1. From the [Start] menu, click [Programs]-[FA-M3 Application]-[ToolBox].
   ⇒ The ToolBox startup screen (screen 9) is displayed.

   **TIP**
   You can also use the ToolBox shortcut icon on the desktop to start ToolBox.

### Terminating ToolBox

1. Click [File]-[Exit] from the menu bar.
   ⇒ ToolBox terminates.

   **SEE ALSO**
   For details on the menu bar, see:
   B1.1 ToolBox Operation Screen
   B1.2 Menu Layout and Command List

   **TIP**
   If a project has been changed and not saved, a message will be displayed for confirmation on whether to save changes. To save changes, click **Save All** or **Yes**. To discard changes, click **No**.
   To cancel the exit operation, click **Cancel**.
A2.5 Functions Available in ToolBox

- **File Management Functions**
  - Project management functions
    - Manages ToolBox user data in projects.
  - Registered parameter management functions
    - Manages registered parameter files registered in a project.
  - Print function
    - Prints (Previews) a project and registered parameter information.
  - Export function
    - Saves a project or registered parameter information in an external file in CSV format.

- **Edit Functions**
  - Project edit function
    - Edits project information. Allows registered parameter file configuration to be used on a destination FA-M3.
  - Registered parameter edit function
    - Edits data in registered parameter files. The parameter setup items and value ranges depend on the specifications of the target module.

- **Communications Functions**
  - Connection functions
    - Connects to and disconnects from a CPU module.

- **Online Functions**
  - Action test function
    - Performs action test by writing register information to the advanced function module.
  - Action monitor function
    - Reads register information from advanced function modules and displays the information on the screen.
  - Operating mode switching function
    - Switches the operating mode (Run, Stop or Debug mode) of the CPU module.
  - Download functions
    - Downloads registered parameter data to advanced function modules or CPU modules.
  - Upload functions
    - Uploads preset data in advanced function modules or CPU modules to the PC and displays the data on the screen.
  - Compare functions
    - Compares preset data in advanced function modules or the CPU module to data in the current open project.
  - ROM management functions
    - Performs operations (transfer or initialization) on ROMs installed in advanced function modules.

- **Extended Functions**
  - Environment setup function
    - Sets up the ToolBox operating environment.
  - Help display functions
    - Displays online help information.

**TIP**

The functions available in ToolBox depend on the setup tool installed. Use of some functions may be restricted or unavailable.
A2.6 Connecting ToolBox and FA-M3 System

System Environment When Using ToolBox

ToolBox can be connected to a FA-M3 sequence CPU module using USB, RS-232C, Ethernet, or FL-net.

Connecting Using USB

Prepare a standard USB cable, which is available commercially.
- Connecting to the PC
  Connect the cable to the USB port of the PC.
- Connecting to the sequence CPU module
  Connect the cable to the USB port located on the front panel of the sequence CPU module. Inserting the cable when the RDY LED is lit initiates installation of the driver software. Follow the displayed messages to install the driver software.

TIP
- Depending on the chipset used by the PC running the WideField3 software, reliable USB connection is not always guaranteed.
- A USB connection may become unreliable or even disconnected due to noise. If this happens, remove and re-attach the USB cable to the PC.

Connecting Using RS-232C

Connect the programming port on a sequence CPU module to the serial port of a PC using a special FA-M3 CPU cable.
Select a cable with an appropriate serial port connector for the PC, as shown in the table below.

Table A2.2  Cables for CPU Port

<table>
<thead>
<tr>
<th>Type</th>
<th>Basic Specifications Code</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>KM11</td>
<td>-2T (3m long)</td>
<td>DOS/V compatible, D-sub 9 pin</td>
</tr>
<tr>
<td></td>
<td>-3T (5m long)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>-4T (10m long)</td>
<td></td>
</tr>
<tr>
<td>KM13</td>
<td>-1N (3m long)</td>
<td>DOS/V compatible</td>
</tr>
<tr>
<td></td>
<td>-1S (3m long)</td>
<td>USB1.1-compliant, for use with USB port</td>
</tr>
</tbody>
</table>
- Connecting to the PC
  Connect the cable to the serial port of the PC. The serial port is located at the back for most PCs but located at the side for some PCs.
- Connecting to the sequence CPU module
  Connect the cable to the PROGRAMMER port of the sequence CPU module. Remove the protective cover from the sequence CPU module to be accessed or configured from ToolBox, and connect the cable securely.

SEE ALSO
When using a USB cable for connection, you may need to configure the serial port on the PC. For more information on the USB-Serial converter cable, see “USB-Serial Converter” (IM34M06C91-01E).

Connecting Using Ethernet
Using a LAN cable, connect the 10BASE5/10BASE-T connector or the network card on a PC to the Ethernet port located on the front panel of a sequence CPU module or the connector on an Ethernet interface module.

SEE ALSO
LAN cables that support 10BASE-5, 10BASE-T or 100BASE-TX communication can be used to connect a PC and an Ethernet Interface Module. Check the target hardware configuration and select an appropriate cable.

For details on how to set up the port of the sequence CPU module, see “Sequence CPU – Network Functions (for F3SP66-4S, F3SP67-6S)” (IM34M06P14-02E).

For details on how to set up and connect the Ethernet Interface Module, see “Ethernet Interface Module” (IM34M06H24-01E).

Connecting Using FL-net
Using a LAN cable, connect the (10BASE5/10BASE-T) connector or the network card on a PC to the connector on the FL-net (OPCN-2) interface module.

SEE ALSO
LAN cables that support 10BASE-5 or 10BASE-T communication can be used to connect a PC and an FL-net (OPCN-2) Interface Module. Check the target hardware configuration and select an appropriate cable.

For details on how to set up and connect the FL-net (OPCN-2) Interface Module, see “FL-net (OPCN-2) Interface Module” (IM34M06H32-02E).

CAUTION
Use FL-net (OPCN-2) Interface Module Rev. 01:00 or later to connect using FL-net.
B1 Using ToolBox

This chapter describes information required for using ToolBox.

- ToolBox Operation Screen → B1.1
- Menu Layout and Command List → B1.2
- ToolBox Operation Commands → B1.3
- Configuring ToolBox → B1.4

B1.1 ToolBox Operation Screen

B1.1.1 Screen Layout

The following picture shows the screen layout for ToolBox. The screen layout and screen operations are compatible to Microsoft Windows.
B1-2

<table>
<thead>
<tr>
<th>Title Bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>The title bar displays the name of the open project, the name of the active window and the name of the file being edited.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu Bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>The menu bar displays the standard menus of ToolBox. Clicking each item on the menu bar displays a pull-down menu, from which available commands can be selected for execution. The set of enabled (available) commands at any point depends on the current CPU operating mode and the action mode. Disabled commands are grayed out in the display.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Project Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>The project window displays the execution parameters of an open project or a list of advanced function module parameter files.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Debugger Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>The debugger window displays debug/maintenance information for each registered parameter file.</td>
</tr>
</tbody>
</table>
# Toolbar

There are two types of toolbars: standard and online. By default, both toolbars are displayed. The toolbars display icons of the most frequently used commands from the menu bar.

To switch between showing and hiding a toolbar, use [View]-[Toolbars].

**TIP**

You can change the content of the toolbar by selecting [Tools]-[Environment Setup for ToolBox] from the menu, and then inserting or deleting commands on the [Toolbar Setup] tab screen.

<table>
<thead>
<tr>
<th>Table B1.1 Standard Toolbar Menu and Online Toolbar Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard Toolbar Menu</strong></td>
</tr>
<tr>
<td>File</td>
</tr>
<tr>
<td>New Project</td>
</tr>
<tr>
<td>Open Project</td>
</tr>
<tr>
<td>Save Project</td>
</tr>
<tr>
<td>New</td>
</tr>
<tr>
<td>Open</td>
</tr>
<tr>
<td>Save</td>
</tr>
<tr>
<td>Save Project</td>
</tr>
<tr>
<td>Print Project</td>
</tr>
<tr>
<td>Project</td>
</tr>
<tr>
<td>Undo</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Copy</td>
</tr>
<tr>
<td>Paste</td>
</tr>
<tr>
<td>Project</td>
</tr>
<tr>
<td>Parameter Configuration Definition</td>
</tr>
<tr>
<td>Change CPU Type/Properties</td>
</tr>
<tr>
<td>Tool</td>
</tr>
<tr>
<td>Environment Setup</td>
</tr>
<tr>
<td>Help</td>
</tr>
</tbody>
</table>

# Window List Bar

The Window List Bar displays a list of icons for windows that are displayed in ToolBox.
Action Status Bar

The action status bar displays the operating status of the FA-M3 (destination CPU Module).

When you connect to an FA-M3 unit, ToolBox automatically determines the CPU type, and displays the corresponding action status bar for the CPU type.

(a) LED display statuses
(b) Name of executable program
(c) Number of executable program steps
(d) CPU operating mode
(e) Scan time
(f) Refresh stop status
(g) Installation status of ROM pack
(h) Sensor control block scan time
(i) LED display statuses
(j) MODE switch value
(k) Write status of internal ROM

<table>
<thead>
<tr>
<th>LED display statuses</th>
<th>Name of executable program</th>
<th>Number of executable program steps</th>
<th>CPU operating mode</th>
<th>Scan time</th>
<th>Refresh stop status</th>
<th>Installation status of ROM pack</th>
<th>Sensor control block scan time</th>
<th>LED display statuses</th>
<th>MODE switch value</th>
<th>Write status of internal ROM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the statuses of the LED indicators of the CPU module.</td>
<td>Displays the name of the executable program stored in the destination CPU module.</td>
<td>Displays the number of steps in the executable program stored in the destination CPU module.</td>
<td>Displays the operating mode (Run, Stop, Debug or ROM) of the CPU module. &quot;ROM&quot; is displayed when another application is writing to the ROM.</td>
<td>Displays the scan time of the CPU module in 0.1 ms increments.</td>
<td>Displays the stop status of refresh operation. X: no refresh of input relays; Y: no refresh of output relays. E: no refresh of shared registers; L: no refresh of link registers.</td>
<td>Displays &quot;ROM mounted&quot; when a ROM pack is installed in the CPU module.</td>
<td>Not used</td>
<td>Displays the statuses of the LED indicators of the CPU module.</td>
<td>Displays the current MODE switch value of the CPU module.</td>
<td>Displays the state of write access to the internal ROM of the CPU module. Blinks when the internal ROM is being edited online from another application.</td>
</tr>
</tbody>
</table>

**CAUTION**

The display of the action status bar is not updated when the monitor is suspended or when uploading is being performed using WideField3. To update the display of the action status bar, resume monitoring, or wait for uploading to complete.
## Status Bar

The status bar displays the status of ToolBox.

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready</td>
<td></td>
<td>Connect</td>
<td>USB, 1</td>
<td>FA3浦7-65</td>
</tr>
</tbody>
</table>

(a) Menu overview Displays a description of the menu at the mouse cursor position.

(b) Monitor status Displays the status of ToolBox's monitoring of FA-M3.

(c) Connection status Displays the connection status and the port number of the currently connected port of the FA-M3 Communication Server.

(d) Communications media Displays the communications speed when connected using RS-232C. When Ethernet is used, displays the IP address and CPU number of the connected module. When FL-net is used, displays the FL-net node number and CPU number of the connected module. When USB is used, displays the CPU number of the connected module.

(e) Destination CPU When a CPU module is connected, displays the model of the connected CPU module. When no CPU module is connected, displays the model of the CPU module specified in the open project.
B1.2 Menu Layout and Command List

This section describes the menu layout and command list of ToolBox. Commands that are enabled (available) at any point depend on the setup tool used, CPU operating mode and action mode. Commands that are disabled and hence not available are displayed in gray. For details on command functions, see Section C1.4, “Menu Bar Overview”.

**TIP**

The list of names displayed under ToolBox Help depends on the toolbox components installed. For instance, “Temperature Control and Monitoring Modules” may be displayed.
B1.3 ToolBox Operation Commands

B1.3.1 Basic Keys

The following table lists the keys used in ToolBox and their purposes.

Table B1.2 Basic Keys

<table>
<thead>
<tr>
<th>Key</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esc</td>
<td>Interrupts execution.</td>
</tr>
<tr>
<td></td>
<td>C cancels the selection of an instruction.</td>
</tr>
<tr>
<td>Tab</td>
<td>Switches input areas in a dialog.</td>
</tr>
<tr>
<td>Insert</td>
<td>Switches between overwrite and insert mode.</td>
</tr>
<tr>
<td>Page Up</td>
<td>Scrolls the screen upwards.</td>
</tr>
<tr>
<td>Page Down</td>
<td>Scrolls the screen downwards.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes one character.</td>
</tr>
<tr>
<td>Shift</td>
<td>Enters a shifted character.</td>
</tr>
<tr>
<td>Backspace</td>
<td>Deletes the character to the left of the cursor position.</td>
</tr>
<tr>
<td>Enter</td>
<td>Enters a carriage return character.</td>
</tr>
<tr>
<td>$</td>
<td>Prefixes a hexadecimal number.</td>
</tr>
<tr>
<td>%</td>
<td>Prefixes a floating-point number.</td>
</tr>
<tr>
<td>*</td>
<td>Delimits a character string.</td>
</tr>
</tbody>
</table>
## Shortcut Keys

In place of selecting commands from the toolbar, shortcut keys offer a faster way to enter commands. The following table lists the commands available for editing.

### Table B1.3  List of Edit Commands

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Undo</td>
<td>[Ctrl]+Z</td>
<td>Undoes the previous operation.</td>
</tr>
<tr>
<td>2</td>
<td>Redo</td>
<td>[Ctrl]+Y</td>
<td>Redoes the previous operation.</td>
</tr>
<tr>
<td>3</td>
<td>Update</td>
<td>[Ctrl]+R</td>
<td>Saves user registered parameters to a file.</td>
</tr>
<tr>
<td>4</td>
<td>Copy</td>
<td>[Ctrl]+C</td>
<td>Copies the content of the selection.</td>
</tr>
<tr>
<td>5</td>
<td>Paste</td>
<td>[Ctrl]+V</td>
<td>Inserts the copied content at the specified location.</td>
</tr>
<tr>
<td>6</td>
<td>Set to Default Value</td>
<td>[Ctrl]+[Shift]+F</td>
<td>Sets the selected cells (lines, columns or multiple cells allowed) to default value.</td>
</tr>
<tr>
<td>7</td>
<td>Set to Maximum Value</td>
<td>[Alt]+M</td>
<td>Sets the selected cells to the maximum allowable value.</td>
</tr>
<tr>
<td>8</td>
<td>Set to Minimum Value</td>
<td>[Alt]+N</td>
<td>Sets the selected cells to the minimum allowable value.</td>
</tr>
<tr>
<td>9</td>
<td>Show</td>
<td>[Ctrl]+[Shift]+G</td>
<td>Shows all hidden columns in an edit screen.</td>
</tr>
<tr>
<td>10</td>
<td>Hide</td>
<td>[Ctrl]+[Shift]+H</td>
<td>Hides the selected column on an edit screen.</td>
</tr>
<tr>
<td>11</td>
<td>Properties</td>
<td>[Ctrl]+[Shift]+Q</td>
<td>Displays information about a user user registered parameter file.</td>
</tr>
</tbody>
</table>

### TIP

- You can also access edit commands from the menu displayed using the right mouse click.
- Other shortcut keys are compatible to Windows.
B1.4 Configuring ToolBox

B1.4.1 Folder Structure

This section describes the default folder structure, which varies with the operating system used.

- **For Windows Vista, Windows 7**

  - C:\ProgramData
    - Yokogawa
      - ToolBox
        - ToolBoxPjt
          - Saves parameter files created by users.
            - Project location: ToolBoxPjt
            - The project location can be changed using ‘Environment Setup’.
      - ToolBox executable module
        - ToolBox.exe and its executable libraries
        - Message box display file, Help files
    - Program Files
      - ToolBox
        - Help

- **For Windows 2000/XP**

  - C:\Documents and Settings\All Users\Application Data
    - Yokogawa
      - ToolBox
        - ToolBoxPjt
          - Saves parameter files created by users.
            - Project location: ToolBoxPjt
            - The project location can be changed using ‘Environment Setup’.
      - ToolBox executable module
        - ToolBox.exe and its executable libraries
        - Message box display file, Help files
    - Program Files
      - ToolBox
        - Help
### Project File Structure

A project consists of four types of files as listed in the following table.

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Extension</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Project information file</td>
<td>.YPPJ</td>
<td><img src="image" alt="Icon" /></td>
<td>Stores project information. Example: TOOLBOXSAMPLE.YPPJ</td>
</tr>
<tr>
<td>2</td>
<td>User registered parameter file</td>
<td>.YPUP***</td>
<td><img src="image" alt="Icon" /></td>
<td>Stores user-edited registered parameters. Example: TOOLBOXSAMPLE.YPUP101</td>
</tr>
<tr>
<td>3</td>
<td>Monitor setup file</td>
<td>.YPMP***</td>
<td><img src="image" alt="Icon" /></td>
<td>Stores action monitor setup information such as monitoring method. Example: TOOLBOXSAMPLE.YPMP101</td>
</tr>
<tr>
<td>4</td>
<td>User environment setup file</td>
<td>.YPDC</td>
<td><img src="image" alt="Icon" /></td>
<td>Stores user-defined environment parameters. Example: TOOLBOXSAMPLE.YPDC</td>
</tr>
</tbody>
</table>

*1: The full pathname of a file must not exceed 254 characters.

*2: Asterisks ("*") in a file name denote numbers corresponding to individual advanced function module types.
### B1.4.2 Environment Setup

Select [Tools]-[Environment Setup for ToolBox] from the menu bar to display the ToolBox Environment Setup screen.

You can setup the required operating environment on the various tab screens.

- **Folder Setup tab**

  Use this tab screen to set the project location used in ToolBox.

![Environment Setup](image)

(a) Folder Setup Tab

(b) Project Location

(c) **Browse** button

(d) **OK** button

(e) **Cancel** button

(f) **Default** button

(g) **Help** button

- **Folder Setup Tab**

  The Folder Setup tab is selected.

- **Project Location**

  Specifies the folder for storing project files. The previous preset value is displayed. For the default folder name, see Section B1.4.1, “Folder Structure”.

- **Browse button**

  Displays the Browse for Folder screen. The folder selected on the Browse for Folder screen is displayed in field (b). You can create the required folder in advance using Windows Explorer.

- **OK button**

  Validates changed settings and closes the screen.

- **Cancel button**

  Closes the screen without changing the settings.

- **Default button**

  Restores the default folder name. A confirmation message is displayed before restoration.

- **Help button**

  Displays help information for ToolBox.
Toolbar Setup tab

Use this tab screen to add or delete icons displayed in the standard toolbar.

(a) Toolbar Setup tab
(b) Content of toolbar
(c) Items to be added to toolbar
(d) <Insert button
(e) >>Delete button
(f) OK button
(g) Cancel button
(h) Default button
(i) Help button

The Toolbar Setup tab is selected.
Displays a list of commands to be displayed in the toolbar.
Displays a list of commands that can be added to the toolbar. Icons that are displayed in area (b) are not displayed in this area.
Inserts the icon selected in area (c) at the selected position in area (b) and shifts following items downwards.
Deletes the icon selected in area (b) at the selected position in area (b) and shifts following items downwards.
Updates the setup and closes the screen.
Closes the screen without saving the setup.
Restores the default values.
Displays help information for ToolBox.
**Language Setup tab**

Use this tab screen to select the display language of ToolBox.

- **Language Setup tab**: The Language Setup tab is selected.
- **Select Language**: Allows you to select the display language of ToolBox.
- **OK button**: Updates the setup and closes the screen.
- **Cancel button**: Closes the screen without saving the setup.
- **Default button**: Restores the default values.
- **Help button**: Displays help information for ToolBox.

**Environment Setup for Advanced Function Modules**

To customize the editing function of the setup tool for a specific advanced function module, select [Tools]-[Environment Setup for Advanced Function Module] from the menu bar where ‘Advanced Function Module’ corresponds to the required module. For more details, see the ToolBox manual for individual setup tools.
B2 Creating Projects

This chapter describes how to create and modify a project.

- Procedure for Creating Projects → B2.1
- Creating New Projects → B2.2
- Modifying Existing Projects → B2.3

A project contains information about the type of the CPU module and registered parameters of advanced function modules comprising an FA-M3 system. Each project contains one CPU.

Registered parameter files collect information about the type and parameter values of advanced function modules. Up to 128 registered parameter files can be created in each project.
### B2.1 Procedure for Creating Projects

<table>
<thead>
<tr>
<th>Stepl</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start ToolBox B2-3</td>
</tr>
<tr>
<td>2</td>
<td>Select a CPU Module B2-3</td>
</tr>
<tr>
<td>3</td>
<td>Enter project name, CPU type and project title.</td>
</tr>
<tr>
<td>4</td>
<td>Create and Edit Registered Parameters B2-4</td>
</tr>
<tr>
<td>5</td>
<td>Create registered parameters for advanced function modules.</td>
</tr>
<tr>
<td>6</td>
<td>Set up System Configuration of FA-M3 B3-23</td>
</tr>
<tr>
<td></td>
<td>Assign registered parameters of advanced function modules to the appropriate FA-M3 slots.</td>
</tr>
</tbody>
</table>
B2.2 Creating New Projects

B2.2.1 Starting ToolBox

1. Switch on the PC and startup Windows.

2. From the [Start] menu, click [Programs]-[FA-M3 Application]-[ToolBox].
   ⇒ ToolBox is started.

B2.2.2 Selecting a CPU Module

1. Click [File]-[New Project] from the menu bar.
   ⇒ Screen 2 is displayed.

2. Enter a project name, CPU type and project title.
   ⇒ For the CPU Type field, select the name of the destination CPU module to be connected from the displayed list.

   Screen 3 shows the setup for this example.
   Project name: Yokogawa2
   CPU Type: F3SP35-5N
   Project Title: Project2

TIP
You can change the CPU type of an existing project by selecting [Project]-[Change CPU Type/Properties] from the menu bar.
However, if CPU devices are specified for use within the project, the specified device range must be valid for the new CPU type (e.g., a case where you have specified to download registered parameters to CPU devices for a temperature control and monitoring module).
3. Click **New**.
⇒ The newly created project information is displayed in the Project Window, as shown in screen 4.

**TIP**

Project Window information:
- Parameter Configuration Definition:
  Defines parameter file configuration for each slot.
- F3SP35-5N:
  Displays the CPU type.
- Parameter Configuration:
  List of registered parameter files contained in a project.

B2.2.3 Creating and Editing Registered Parameters

This section describes how to create registered parameters for advanced function modules.

⇒ A screen similar to screen 5 is displayed. Screen 5 shows an example for the ToolBox for Temperature Control and Monitoring Modules.

**TIP**

If multiple setup tools are installed, select the appropriate item from the displayed screen.

2. The actual edit operations for the selected advanced function module depend on the setup tool. For details, refer to this manual, as well as the manual provided for each setup tool.

**TIP**

Registered parameter files created using various setup tools are added and stored in a project.
B2.3 Modifying Existing Projects

B2.3.1 Opening a Project

This section describes how to open an existing project, which was created previously.

1. Click [File]-[Open Project] from the menu bar.
⇒ Screen 6 is displayed.

2. Select the project to be opened and click [Open].
   
   **TIP**
   You can also open a project by selecting and double-clicking the project.

⇒ Screen 7 is displayed.

3. Select the file to be opened and click [Open].
   
   **TIP**
   You can also open a file by selecting and double-clicking the file.

⇒ The project is read and the project information is displayed in the project window.

   
   **TIP**
   You can also open a registered parameter file of an advanced function module by selecting and double-clicking the file.

5. The actual edit operations for the selected advanced function module depend on the setup tool. For details, refer to this manual, as well as the manual provided for each setup tool.
   
   **TIP**
   Registered parameter files created using various setup tools are added and stored in a project.
B2.3.2 Modifying a Project

This section describes how to add registered parameter files to a project from another project, as well as how to rename and delete registered parameter files within a project.

■ Insert File

To add a registered parameter file from another project to the currently opened project, use the following procedure.

   ⇒ The Select File dialog is displayed.

   **TIP**
   If multiple setup tools are installed, select the appropriate item from the displayed screen.

2. Select the registered parameter file to be added, and then click Select.

■ Rename File

To rename a registered parameter file in a project, use the following procedure.

   ⇒ The Select File dialog is displayed.

   **TIP**
   If multiple setup tools are installed, select the appropriate item from the displayed screen.

2. Select the registered parameter file to be renamed, and then click Select.
   ⇒ The Rename File dialog is displayed.

3. Enter a new filename and click OK.
Delete File

To delete a registered parameter file from a project, use the following procedure.

   ⇒ The Select File dialog is displayed.

   **TIP**
   If multiple setup tools are installed, select the appropriate item from the displayed screen.

2. Select the registered parameter file to be deleted, and then click [Select].

Change Module Type

You can change the selected module type for a registered parameter file.

1. Select [Project]-[Change Module Type] from the menu bar.
   ⇒ The Select File dialog is displayed.

2. Select the registered parameter file whose module type is to be changed, and then click [Select].
   ⇒ The Change Module Type dialog box is displayed.

3. Select a module type to be changed, and click [Select].
B3 Setting up Connections and Connecting to FA-M3

This chapter describes how to connect and setup communications between FA-M3 and PC.

- Communications Setup → B3.1
- Connecting and Disconnecting → B3.2
- FA-M3 System Configuration Setup → B3.3

B3.1 Communications Setup

This chapter describes how to set up communications for using the online functions of ToolBox.

There are four ways to establish an online connection from the PC where ToolBox is installed to the CPU module of an FA-M3 unit. The communication media available for connection to different CPU types vary, as shown in Table B3.1 below. When performing online connection, select an appropriate medium for the target CPU type accordingly.

Table B3.1 CPU Types and Available Communication Media

<table>
<thead>
<tr>
<th>Communication Media</th>
<th>F3SP66-4S</th>
<th>F3SP67-6S</th>
<th>F3SP71-4N</th>
<th>F3SP71-4S</th>
<th>F3SP76-7N</th>
<th>F3SP76-7S</th>
<th>Other CPU Types</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB</td>
<td>✓</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>In a multi-CPU configuration, online connection can be made to all CPU modules via the port of any CPU that allows USB connection.</td>
</tr>
<tr>
<td>RS-232C</td>
<td>x</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td>This includes connection via KM13 or a modem.</td>
</tr>
<tr>
<td>Ethernet</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>This includes connection via an Ethernet Internet Module or via the Ethernet port of a CPU module.</td>
</tr>
<tr>
<td>FL-net</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>This refers to connection via an FL-net (OPCN-2) Interface Module.</td>
</tr>
</tbody>
</table>

TIP
- When communicating via a modem, you need to initialize the modem on the CPU module end, and set up communications for the CPU module to 9600 bps, with no parity.
- If you have installed a modem driver on the PC, you may be prompted to reboot the PC.

SEE ALSO

On F3SP71-4N/F3SP76-7N/F3SP71-4S/F3SP76-7S, you can use the user authentication and operation protection functions. To set these functions for ToolBox, you can configure the security settings using "FA-M3 Defender".

For details on functions and operations of "FA-M3 Defender", see "FA-M3 Programming Tool WideField3 User's Manual (Online Functions)".

---

CAUTION

Use FL-net (OPCN-2) Interface Module Rev. 01:00 or later to connect using FL-net.
Communication Ports and Online Configuration

ToolBox makes online connections to CPU modules via "FA-M3 Communication Server", which is a communication software application for supporting online functions between FA-M3 and the PC.

FA-M3 Communication Server provides 16 "communication ports". You can set up communications for each communication port.

**TIP**

The communication port settings are used also for FA-M3 support software applications (e.g., WideField3).

When an application is using a port, another application can make an online connection using the settings of the port in use. If multiple ports have the same settings, those ports cannot be online at the same time.

**SEE ALSO**

For details on the functions of FA-M3 Communication Server, see Section B3.4, "FA-M3 Communication Server".
Communications Setup

1. Start ToolBox and select [Online]-[Connect] from the menu bar.
   ⇒ The Connection Check dialog box is displayed.

2. Click the [Setting...] button of the communication port to configure the settings.
   ⇒ The Communications Setup dialog box for the specified port is displayed.

3. Refer to Table B3.2, "Communications Setup Overview" and configure the settings for the communication media. Then, click [OK] to determine the settings.

   TIP
   Configure the network and modem settings by referring to the instruction manuals of individual devices and the PC. For details on the network settings, contact your network administrator.
## Table B3.2 Communications Setup Overview

<table>
<thead>
<tr>
<th>Communications Protocol</th>
<th>Item</th>
<th>Overview</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual FA-M3 Connection</td>
<td>Connection Timeout</td>
<td>ToolBox does not support the connection to Virtual FA-M3.</td>
</tr>
<tr>
<td>USB Communication</td>
<td>Connection Timeout</td>
<td>Specify the connection timeout interval (in seconds). When using direct connection, this value is automatically determined and hence need not be specified.</td>
</tr>
</tbody>
</table>
| RS-232C Communication   | Connection Method     | If you have selected RS-232C connection, then set the Connection Method as follows:  
  - Automatic Recognition: system automatically determines the transmission rate and parity.  
  - Fixed: uses a fixed transmission rate and parity.  
  Set the transmission rate (bps) to any of the following values: 9,600; 19,200; 38,400; 57,600 or 115,200.  
  Set the parity to any of the following values: Even or None |
|                         | Communications Timeout| Specify the communications timeout (in seconds) when using RS-232C connection. |
|                         | Number of Retries     | Specify the number of retries when using RS-232C connection.              |
|                         | COM Port Number       | Specify the serial (COM) port number when using RS-232C connection.       |
| RS-232C via Modem       | Connection Name       | When connecting via modems, select from a list of registered dialup connections to specify the telephone number. At the time of actual connection, the connection name will be displayed on the connection confirmation screen. |
| Ethernet Communication  | Destination           | Specify the IP address or hostname of the destination.                   |
|                         | IP Address            | Set the network IP address of the PC using Windows.                      |
|                         | Connection Timeout    | Specify the connection timeout interval (in seconds) when using Ethernet connection. |
| FL-net Communication    | Node Number           | Specify the FL-net node number of the destination from 1 to 254. Set up the destination IP address so that the three high-order bytes of the IP addresses of the PC and the FL-net (OPCN-2) Interface Module are the same, and also ensure that the least significant byte of the destination IP address, which will become the node number (1 to 254) of the destination, is different from the node number of the PC. |
|                         | Local Node Setup      | If multiple network cards are installed in a PC, specify the IP address of the network card to be used, and also set up the node number of the local node. |
B3.2 Connecting and Disconnecting

This section describes how to perform online connection to the FA-M3.

**TIP**
- If connection is unsuccessful, a communication error message will be displayed. If this happens, check the cable connections and the communications setup in the environment setup.
- If another application is connected online to FA-M3 when you try to perform online connection in ToolBox, the system will open the connection to the same sequence CPU module using the same communication medium.

B3.2.1 Direct Connection

Direct connection establishes an online connection between ToolBox and FA-M3.

**USB Connection**

The table below shows the system requirements for establishing an online connection using USB.

<table>
<thead>
<tr>
<th>Compatible CPU Type</th>
<th>Connection Cable</th>
</tr>
</thead>
<tbody>
<tr>
<td>F3SP66-4S/F3SP67-6S/F3SP71-4N/F3SP76-7N/F3SP71-4S/F3SP76-7S</td>
<td>USB1.1 or 2.0 compliant generic USB cable</td>
</tr>
</tbody>
</table>

**TIP**
Depending on the chipset used by the PC running the ToolBox software, reliable USB connection is not always guaranteed.

The figures below show two possible configurations for USB connection.

♦ Connecting to a CPU using a USB cable attached to its USB port
  Connect a USB cable between the PC and the CPU module to be connected and initiate online connection, specifying the installation no. of the CPU module to be connected as the target CPU module.

  For the example configuration shown below, the CPU number can be specified as either 0 or 1. (Specifying "0" initiates connection to the CPU module attached with the USB cable.)

  To connect to an add-on CPU, specify CPU 2, 3 or 4.

  ![USB Connection Diagram 1](image1.png)

♦ Connecting to a CPU via the USB Port of another CPU
  Connection can be made to a CPU not directly attached to a USB cable by going through another CPU attached with a USB cable.

  As shown in the example configuration below, the USB cable is attached to CPU 1 but CPU 4 can be specified as the destination when initiating an online connection.

  ![USB Connection Diagram 2](image2.png)
The procedure for online connection using USB is described below.

The table below lists the setup required for USB connection.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Media</td>
<td>Select [USB].</td>
<td></td>
</tr>
<tr>
<td>CPU No.</td>
<td>Specify the installed slot number of the actual CPU module to be connected.</td>
<td>0-4</td>
</tr>
<tr>
<td></td>
<td>Note: Specifying 0 initiates connection to the CPU module attached with the USB cable.</td>
<td></td>
</tr>
</tbody>
</table>

1. Select [Online]–[Connect] from the menu bar.

⇒ The Connection Check dialog box is displayed.

TIP
If another application is already connected online to the FA-M3, the existing connection information is displayed and connection is made using the same communication medium.

2. Select a port for which USB is specified as the communication medium, and click [Connect].

⇒ The FA-M3 and PC is connected. The connection status is displayed in the action status bar and status bar located at the bottom of the operation screen.

SEE ALSO
When you connect to a CPU module on which the login authentication by password based on the security function is enabled, you need to enter the user name and password.

For details on the login authentication with FA-M3 Defender for CPU modules and procedure for entering a password, see "WideField3 User's Manual" (IM34M06Q16-0□E).

SEE ALSO
Before initiating online connection using USB, USB driver software for FA-M3 must be installed on the personal computer. For more details on the installation, see Section A2.3.3, "Installing USB Driver."
If a USB connection is disconnected due to communication error, the USB driver may be in an unknown state. To rectify the problem, remove and re-attach the USB cable, or power off and then power on the FA-M3. A USB connection may become unreliable or even disconnected due to noise. If this happens, remove and re-attach the USB cable to the PC.

**RS-232C Connection**

The table below shows the system requirements for establishing an online connection using RS-232C.

<table>
<thead>
<tr>
<th>Compatible CPU Type</th>
<th>Connection Cable</th>
</tr>
</thead>
<tbody>
<tr>
<td>F3SP28-3S/F3SP53-4S/F3SP38-6S/F3SP58-6S/F3SP59-7S</td>
<td>Special (KM11-1T/KM13-1S) cable</td>
</tr>
<tr>
<td>F3SP28-3N/F3SP53-4N/F3SP38-6N/F3SP59-6N</td>
<td></td>
</tr>
<tr>
<td>F3SP22-0S/F3SP21-0N/F3SP25-2N/F3SP35-5N/F3FP36-3N</td>
<td></td>
</tr>
<tr>
<td>F3SP05-0P/F3SP08-0P/F3SP08-SP</td>
<td></td>
</tr>
<tr>
<td>F3SPV3-4H/F3SPV8-6H</td>
<td></td>
</tr>
</tbody>
</table>

The figures below show the possible configurations for RS-232C connection.

- **Connecting Using Proprietary Cable / KM11-1T**
  
  Connect a proprietary cable between the serial port of the PC and the PROGRAMMER port of the CPU module to be connected, and then initiate online connection.

- **Connecting Using Proprietary Cable / KM13-1N, -1S**
  
  Connect a proprietary cable between the USB port of the PC and the PROGRAMMER port of the CPU module to be connected, and then initiate online connection.

**TIP**

Before initiating online connection using KM13-1N, -1S, proprietary driver software must be installed on the personal computer.

The installation instructions and the driver software itself are provided with the cable.
The procedure for establishing an online connection using RS-232C is described below.

The table below lists the setup required for RS-232C connection.

<table>
<thead>
<tr>
<th>Items to be specified in environment setup</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td></td>
</tr>
<tr>
<td>Communication Media</td>
<td>Select [RS-232C]</td>
</tr>
<tr>
<td>Connection Method</td>
<td>Specify the transmission speed and parity defined for the PROGRAMMER port. If &quot;Automatic Recognition&quot; is selected, connection is established automatically using the defined values.</td>
</tr>
<tr>
<td>[Transmission speed]</td>
<td>9,600/19,200 38,400/57,600 115,200 bps</td>
</tr>
<tr>
<td>[Parity]</td>
<td>Even/None</td>
</tr>
<tr>
<td>Communication Timeout</td>
<td>Specify the interval for timeout during communications. Note: For normal use, the default values can be used and no setup is required.</td>
</tr>
<tr>
<td></td>
<td>1-100 [s]</td>
</tr>
<tr>
<td>Number of Retries</td>
<td>Specify the number of retries in the event of communication failure. Note: For normal use, the default values can be used and no setup is required.</td>
</tr>
<tr>
<td></td>
<td>1-100 [attempts]</td>
</tr>
<tr>
<td>COM Port Number</td>
<td>Specify the serial port number on the PC.</td>
</tr>
<tr>
<td></td>
<td>COM1-COM100</td>
</tr>
</tbody>
</table>

1. Select [Online]-[Connect] from the menu bar.
   ⇒ The Connection Check dialog box is displayed.

   **TIP**
   If another application is already connected online to the FA-M3, the existing connection information is displayed and connection is made using the same communication medium.

2. Select a port for which COM is specified as the communication medium, and click [Connect].
   ⇒ The PC and FA-M3 are connected. The connection status is displayed on the action status bar and status bar at the bottom of the operation screen.

   **TIP**
   When connected using RS-232C, you can change the transmission rate to the highest speed allowed for the CPU module after connection is completed. At the time of disconnection, the transmission rate can be restored to its original value at the time of connection.
   If the FA-M3 is not disconnected normally using an online operation after transmission rate is changed, the modified rate will be retained in the CPU module. To revert to the original transmission rate, re-apply power to the CPU module, or change the transmission rate by selecting [Online]-[Temporarily Change Communication Speed] from the menu.
## Ethernet Connection

The table below shows the system requirements for establishing an online connection using Ethernet.

<table>
<thead>
<tr>
<th>Compatible CPU Types</th>
<th>Connection Cable</th>
</tr>
</thead>
<tbody>
<tr>
<td>F3SP66-4S/F3SP67-6S/F3SP71-4N/F3SP76-7N</td>
<td></td>
</tr>
<tr>
<td>F3SP71-4S/F3SP76-7S*1</td>
<td></td>
</tr>
<tr>
<td>F3SP28-3S/F3SP53-4S/F3SP38-6S/F3SP58-6S/F3SP59-7S</td>
<td></td>
</tr>
<tr>
<td>F3SP28-3N/F3SP53-4N/F3SP38-6N/F3SP58-6N</td>
<td></td>
</tr>
<tr>
<td>F3SP22-0S/F3SP21-0N/F3SP25-2N/F3SP35-5N/F3FP36-3N</td>
<td></td>
</tr>
<tr>
<td>F3SP05-0P/F3SP08-0P/F3SP08-SP</td>
<td></td>
</tr>
<tr>
<td>F3SPV3-4H/F3SPV8-6H</td>
<td></td>
</tr>
</tbody>
</table>

*1: For F3SP66-4S/F3SP67-6S/F3SP71-4N/F3SP76-7N/F3SP71-4S/F3SP76-7S CPU modules, connection can be made using the Ethernet port on the CPU module or via an Ethernet Interface Module. In both cases, the procedure for connection from ToolBox is identical.

The description in this chapter assumes connection via an Ethernet Interface Module for purpose of explanation.

The figures below show two possible configurations for Ethernet connection.

**Direct Connection**

Connect a cross cable between the LAN port of the PC and the Ethernet Interface Module of the FA-M3 unit (or the Ethernet port of the CPU module if present). Even in the case of direct connection, network setup is required to identify the destination CPU.

![Direct Connection Diagram](image)

**Connecting to FA-M3 over a Network**

When connecting to FA-M3 on a network configured using Ethernet, the network setup of the PC must match the FA-M3 network.

![Connecting to FA-M3 over a Network Diagram](image)
The procedure for online connection using Ethernet is described below.

The table below lists the setup required for Ethernet connection.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Media</td>
<td>Select [Ethernet].</td>
<td></td>
</tr>
<tr>
<td>Destination IP Address</td>
<td>Specify the network IP address or hostname defined in the Ethernet interface.</td>
<td></td>
</tr>
<tr>
<td>Connection Timeout</td>
<td>Specify a timeout interval for bad connection during communications.</td>
<td>1-120 s</td>
</tr>
<tr>
<td>CPU No.</td>
<td>Specify the installed slot number of the actual CPU module to be connected.</td>
<td>1-4</td>
</tr>
</tbody>
</table>

1. **Select [Online]-[Connect] from the menu bar.**

⇒ The Connection Check dialog box is displayed.

**TIP**

If another application is already connected online to the FA-M3, the existing connection information is displayed and connection is made using the same communication medium.

2. **Select a port for which Ethernet is specified as the communication medium, and click [Connect].**

⇒ The PC and FA-M3 are connected. The connection status is displayed on the action status bar and the status bar at the bottom of the operation screen.

**TIP**

When you connect to a CPU module on which the login authentication by password based on the security function is enabled, you need to enter the user name and password.

For details on the login authentication with FA-M3 Defender for CPU modules and procedure for entering a password, see "WideField3 User's Manual" (IM34M06Q16-00E).
**FL-net Connection**

The table below shows the system requirements for establishing an online connection using FL-net.

<table>
<thead>
<tr>
<th>Compatible CPU Types</th>
<th>Connection Cable</th>
</tr>
</thead>
<tbody>
<tr>
<td>F3SP66-4S/F3SP67-6S/F3SP71-4N/F3SP76-7N</td>
<td>Generic LAN cable</td>
</tr>
<tr>
<td>F3SP71-4S/F3SP76-7S</td>
<td>Note: Select either a cross cable or a straight cable, depending on the configuration.</td>
</tr>
<tr>
<td>F3SP28-3S/F3SP53-4S/F3SP38-6S/F3SP58-6S/F3SP59-7S</td>
<td></td>
</tr>
<tr>
<td>F3SP28-3N/F3SP53-4N/F3SP38-6N/F3SP58-6N</td>
<td></td>
</tr>
<tr>
<td>F3SP22-0S/F3FP36-3N</td>
<td></td>
</tr>
<tr>
<td>F3SPV3-4H/F3SPV8-6H</td>
<td></td>
</tr>
</tbody>
</table>

The figures below show two possible configurations for FL-net connection.

- **Direct Connection**
  
  Connect a cross cable between the LAN port of the PC and the FL-net Interface Module of the FA-M3 unit. Even in the case of direction connection, network setup is required to identify the connection destination.

- **Connecting to FA-M3 over a Network**

  When connecting to an FA-M3 network configured using FL-net, the network setup on the PC must match the FA-M3 network.
The FL-net connection function makes use of the vendor-specific message request and vendor-specific message response features of the message transmission and receiving functions of FL-net, and does not require any special setup if ToolBox is used.

Observe the following precautions and restrictions of the FL-net connection function.

1. Compatible sequence CPU modules
   FL-net connection is not available with the following CPU modules: F3SP05/08/21/25/35.
   Connection to sequencers from other suppliers is also not allowed.

2. Accessing the same sequence CPU concurrently from multiple PCs
   Using one FL-net (OPCN-2) Interface Module enables concurrent access to the same sequence CPU module from up to 2 PCs.

3. Performance of remote maintenance
   Due to the use of FL-net message transmission and receiving functions, the response speed for remote maintenance may deteriorate under the following conditions:
   - Large common memory size
   - Large number of nodes
   - Frequent message communication among nodes

4. Detaching the communication cable during online connection
   Do not detach the communication cable between the PC and FA-M3 when the PC is connected to the FL-net. If you remove the communication cable, the following error message may be displayed on the PC. If this happens, click No to disconnect and then reconnect.

5. List of FL-net connection error messages
   The following table lists the error codes that may be displayed together with the error message “Failed to connect to FA-M3” when connecting from the PC to the FL-net. It also lists possible cases and troubleshooting tips.

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Cause</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td>80040006-0001</td>
<td>Invalid network address segment in the destination IP address specified in the environment setup.</td>
<td>Check the network address segment in the specified destination IP address.</td>
</tr>
<tr>
<td>80040005-0007</td>
<td>Invalid IP address specified for the PC.</td>
<td>Check the IP address allocated to the PC in the network setup of the PC.</td>
</tr>
<tr>
<td></td>
<td>Invalid network card specified in the local node setup of the environment setup.</td>
<td>Check the network card specified in the local node setup.</td>
</tr>
<tr>
<td>80040006-0002</td>
<td>The specified destination node is not an FA-M3 node.</td>
<td>Check the value specified for destination node.</td>
</tr>
<tr>
<td></td>
<td>Invalid node number specified in the local node setup in the environment setup.</td>
<td>Check the node number specified in the local node setup.</td>
</tr>
<tr>
<td>80040006-0000</td>
<td>The specified destination node is not participating in the network, or the communication cable is detached.</td>
<td>- Check the node number of the IP address of the specified destination.</td>
</tr>
<tr>
<td></td>
<td>Invalid node number specified in the local node setup in the environment setup.</td>
<td>- Check the communication cable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check the node number specified in the local node setup.</td>
</tr>
</tbody>
</table>

Note: For an IP address used in FL-net, the three high bytes denote the network address, while the least significant byte denotes the host address (node number).
(6) FL-net communication under Windows XP SP2 or later

Windows XP SP2 and later (including Windows Vista and Windows 7) feature enhanced security functions. The installed firewall function may affect online connection using FL-net protocol in ToolBox.

We describe here how to perform FL-net connection using Windows XP as an example. (For setting examples under Windows Vista/Windows 7, see "ToolBox Read Me First" (IM34M06Q30-11E or IM34M06Q30-21E).)

(i) Connecting using FL-net communication in ToolBox

1. When executing online connection using FL-net communication in ToolBox, you may see the following security warning window. Select [Unblock] in response to the question: "Do you want to keep blocking this program?" to allow this and future connections.

![Windows Security Alert]


If you select [Keep Blocking], you can still enable communication subsequently by configuring the Windows Firewall as described in paragraph (ii), "Configuring Windows Firewall to allow online connection using FL-net communication".

(ii) Configuring Windows Firewall to allow online connection using FL-net communication

The setup described below can only be performed if you have selected [Keep Blocking] on the screen described in (i) above. This setup is not required if you have selected [Unblock] instead.

1. Select and open Security Center from Windows control panel.
2. Select and open Windows Firewall from the Windows Security Center screen.

3. Configure Windows Firewall using the Exceptions tab and Advanced tab. Although you can disable Windows Firewall by selecting [Off] on the General tab screen, we do not recommend doing so.

4. Click the Exceptions tab and perform setup as shown in the following screen.
5. Select the Advanced tab, and click [Settings] in the ICMP group box.

6. Turn on all checkboxes on the ICMP Settings screen. This configures Windows Firewall to allow ycomsrv (mcomsrvex) requests and responses to pass through.

7. The setup is completed. Click [OK] to close all windows.
**CAUTION**

Use FL-net (OPCN-2) Interface Module Rev. 01:00 or later to connect using FL-net.

The procedure for online connection using FL-net is described below.

The table below lists the setup required for FL-net connection.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Media</td>
<td>Select [FL-net].</td>
<td></td>
</tr>
<tr>
<td>Destination IP address</td>
<td>Specify the node number defined in the FL-net interface of the network.</td>
<td>1-254</td>
</tr>
<tr>
<td>Local Node Setup</td>
<td>This setup identifies the local node (PC) as a node on the FL-net.</td>
<td></td>
</tr>
<tr>
<td>Target Unit CPU No.</td>
<td>Specify the installed slot number of the actual CPU module to be connected.</td>
<td>1-4</td>
</tr>
</tbody>
</table>

1. Select [Online]-[Connect] from the menu bar.

⇒ The Connection Check dialog box is displayed.

**TIP**

If another application is already connected online to the FA-M3, the existing connection information is displayed and connection is made using the same communication medium.

2. Select a port for which FL-net is specified as the communication medium, and click [Connect].

⇒ The PC and FA-M3 are connected. The connection status is displayed on the action status bar and the status bar at the bottom of the operation screen.

**TIP**

When you connect to a CPU module on which the login authentication by password based on the security function is enabled, you need to enter the user name and password.

For details on the login authentication with FA-M3 Defender for CPU modules and procedure for entering a password, see "WideField3 User's Manual" (IM34M06Q16-0□E).
RS-232C Connection via Modem

The table below shows the system requirements for establishing an online connection using RS-232C via a modem.

<table>
<thead>
<tr>
<th>Compatible CPU Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>F3SP28-3S/F3SP53-4S/F3SP38-6S/F3SP58-6S/F3SP59-7S</td>
</tr>
<tr>
<td>F3SP28-3N/F3SP53-4N/F3SP38-6N/F3SP58-6N</td>
</tr>
<tr>
<td>F3SP22-0S/F3SP21-0N/F3SP25-2N/F3SP35-5N/F3FP36-3N</td>
</tr>
<tr>
<td>F3SP05-0P/F3SP08-0P/F3SP08-SP</td>
</tr>
<tr>
<td>F3SPV3-4H/F3SPV8-6H</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Connection Equipment</th>
<th>Connection Cable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generic modem</td>
<td>Proprietary (KM11-*T) cable, serial cable (straight cable)</td>
</tr>
</tbody>
</table>

The figure below shows the configuration for RS-232C connection via a modem.

- Basic Configuration for Connection Using a Modem and KM11-*T Cable

  Connect a serial cable (straight cable) between the serial port of the PC and a modem, and connect a proprietary cable between the PROGRAMMER port of the CPU module and a modem.

![Diagram of RS-232C Connection via Modem](image-url)
The procedure for establishing an online connection using RS-232C via a modem is described below.

The table below lists the setup required for RS-232C connection via a modem.

<table>
<thead>
<tr>
<th>Item to be specified in environment setup</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Media</td>
<td>Select [RS-232C via Modem].</td>
<td></td>
</tr>
<tr>
<td>Connection Method</td>
<td>Specify the transmission speed and parity defined for the PROGRAMMER port. If &quot;Automatic Recognition&quot; is selected, connection is established automatically using the defined values.</td>
<td>[Transmission Speed] 9,600/19,200 38,400/57,600 115,200 bps</td>
</tr>
<tr>
<td>Communication Timeout</td>
<td>Specify the interval for timeout during communications.</td>
<td>1-100 [s]</td>
</tr>
<tr>
<td>Number of Retries</td>
<td>Specify the number of retries in the event of communication failure.</td>
<td>1-100 (attempts)</td>
</tr>
<tr>
<td>COM Port Number</td>
<td>Specify the serial port number on the PC.</td>
<td>COM1-COM100</td>
</tr>
<tr>
<td>Phone Number</td>
<td>Specify the telephone number for modem dialing.</td>
<td></td>
</tr>
</tbody>
</table>

1. Select [Online]-[Connect] from the menu bar.
⇒ The Connection Check dialog box is displayed.

   **TIP**
   
   The "Modem" string displayed in screen 6 is the connection name selected in the modem setup on the communications setup tab screen described in Section B3.1.

2. Select a port for which RS-232C via Modem is specified as the communication medium, and click [Connect].
⇒ The PC and FA-M3 are connected. The connection status is displayed on the action status bar and the status bar at the bottom of the operation screen.
B3.2.2 Disconnecting

Disconnecting

1. Select [Online]-[Disconnect] from the menu bar.
   ⇒ A disconnection confirmation message is displayed.

2. Click [Yes].
   ⇒ Toolbox is disconnected from the CPU module.
B3.2.3 Temporarily Changing Communication Speed

1. Confirm that ToolBox is connected online.

   **TIP**
   The function for changing communication speed temporarily is only available when connection is via RS-232C.

   **SEE ALSO**
   For details on online connection procedures, see Section B3.2.1, "Direct Connection."

2. Select [Online]-[Temporarily Change Communication Speed] from the menu bar.

   ⇒ The Temporarily Change Communication Speed dialog box is displayed.

3. Select a communication speed and click **OK**.

   ⇒ A change confirmation message is displayed.

4. Click **Yes**.

   **CAUTION**
   Do not change the communication speed using ToolBox while a program is being downloaded using WideField3. Otherwise, the download may not work properly.
B3.2.4 Local Node Setup

When connecting from the PC to FA-M3 using FL-net as communication medium in ToolBox software, you can specify a local IP address and node number. For instance, if multiple network cards are installed in the PC, you can specify which network card is to be used when initiating an FL-net connection. In addition, you can also specify a node number for identifying the network card on the FL-net. The least significant byte of the IP address of the network card is normally used as the node number but you can also specify a node number, independent of the IP address, when performing a temporary connection between the PC and FA-M3 using FL-net. You need to set different node numbers for the PC and FA-M3 so you should select a node number that is usually not used, such as a number close to 254.

**TIP**

If only one network card is installed in the PC or the network card with the highest priority is to be used, you need not set up the network card to be used in FL-net connection.

---

**CAUTION**

If multiple network cards installed in a PC are used as FL-net nodes, the software may not run properly.

1. Open the Communications Setup dialog box for the communication port.
2. Select FL-net from the Communication Media group box.
⇒ The [Set up Local Node] button becomes active in the display.

3. Click [Set up Local Node].
⇒ The Local Node Setup dialog box is displayed.

4. Set up the required screen items (see Table B3.4, Local Node Setup) and click [OK].

Table B3.4 Local Node Setup

<table>
<thead>
<tr>
<th>Set up Network Card on PC</th>
<th>Set up Node Number of PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Specified</td>
<td>Specify</td>
</tr>
<tr>
<td>The IP address allocated to the network card in the network setup of the operating system will be used.</td>
<td>Use the least significant byte of the IP address as the node number. The IP address may be determined by the operating system settings or by the user as described in column 1 and 2 of this table.</td>
</tr>
<tr>
<td>Specify</td>
<td>Not Specified</td>
</tr>
<tr>
<td>Specify the IP address of the network card to be used for FL-net connection.</td>
<td>Specify any number from 1 to 254 as the node number for identifying the network card on the FL-net.</td>
</tr>
</tbody>
</table>

**CAUTION**

You cannot connect to CPU modules F3SP05, F3SP08, F3SP21, F3SP25 or F3SP35 using FL-net (OPCN-2).
B3.3 FA-M3 System Configuration Setup

This section describes how to perform parameter configuration definition of a created project to match the configuration of all advanced function modules installed in a FA-M3 system. To save registered parameters in the CPU module, specify the CPU data (file) registers using detailed setup in parameter configuration definition.

B3.3.1 System Configuration Setup

1. Select [Project]-[Parameter Configuration Definition] from the menu bar.
   ⇒ The Parameter Configuration Definition dialog box is displayed.

2. You can check the actual configuration of advanced function modules installed in the connected FA-M3 by clicking I/O Configuration.
   SEE ALSO
   Read manuals for advanced function modules used.

3. Select a slot in the left box and the appropriate file on the right box, and click Select.
   Make assignments to all slots.
   ⇒ Screen 2 is displayed.

4. Select a slot and click Detailed Setup.
   ⇒ Screen 3 is displayed.
5. Read manuals of setup tools and set up the required items.

**CAUTION**

For each module, specify a “From” field that is different from other modules in the project, or any ladder programs already stored in the CPU module. Specifying the same address may lead to overwriting and hence, incorrect data storage.

6. Click **OK**

⇒ The Parameter Configuration Definition screen closes.

### B3.3.2 When the FA-M3 Installation Configuration is Changed

When the installation configuration of the FA-M3 is changed, say, by the removal of an advanced function module, CPU registers may become available

For instance, if advanced function module 2 is removed from the existing installation, register 2 becomes available. Read the manual provided for each setup tool to change the register allocation to remove the gap.

**Before change:**

<table>
<thead>
<tr>
<th>Slot</th>
<th>FA-M3 Installation Configuration</th>
<th>CPU Register Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slot 4</td>
<td>Registered parameter file of advanced function module 1</td>
<td>Registers 1</td>
</tr>
<tr>
<td>Slot 5</td>
<td>Registered parameter file of advanced function module 2</td>
<td>Registers 2</td>
</tr>
<tr>
<td>Slot 6</td>
<td>Registered parameter file of advanced function module 3</td>
<td>Registers 3</td>
</tr>
</tbody>
</table>

**After change**

<table>
<thead>
<tr>
<th>Slot</th>
<th>FA-M3 Installation Configuration</th>
<th>CPU Register Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slot 4</td>
<td>Registered parameter file of advanced function module 1</td>
<td>Registers 1</td>
</tr>
<tr>
<td>Slot 5</td>
<td></td>
<td>Registers 2</td>
</tr>
<tr>
<td>Slot 6</td>
<td>Registered parameter file of advanced function module 3</td>
<td>Registers 3</td>
</tr>
</tbody>
</table>
B3.4 FA-M3 Communication Server

FA-M3 applications use a dedicated communication application called FA-M3 Communication Server to exchange online information with FA-M3.

When an application is started or online connection is started, FA-M3 Communication Server automatically resides in the system and processes communication requests by the application.

Usually, communication-related setting and processing are performed through applications that use FA-M3 Communication Server, and you do not need to operate FA-M3 Communication Server directly. But, you can access FA-M3 Communication Server resident in the system to utilize the functions for communicating with FA-M3.

This chapter describes the specifications and functions of FA-M3 Communication Server.

B3.4.1 Specifications

This section describes the specifications of FA-M3 Communication Server.

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Ports</td>
<td>16</td>
</tr>
<tr>
<td>Compatible CPU Modules</td>
<td>F3SP05-0P, F3SP08-0P, F3SP08-SP, F3SP21-0N, F3SP25-0N, F3SP35-5N, F3SP28-3N, F3SP38-6N, F3SP53-4H, F3SP58-6H, F3FP36-3N, F3SP22-0S, F3SP28-3S, F3SP38-6S, F3SP53-4S, F3SP58-6S, F3SP59-7S, F3SP66-4S, F3SP67-6S, F3SP71-4N, F3SP76-7N, F3SPV3-4H, F3SPV8-6H</td>
</tr>
<tr>
<td>Communication Media</td>
<td>USB, RS-232C, RS-232C via Modem, Ethernet, FL-net (OPCN-2 or later)</td>
</tr>
<tr>
<td>Security Functions</td>
<td>Supports the security settings for F3SP71-4N and F3SP76-7N.</td>
</tr>
</tbody>
</table>
B3.4.2 System Tray Icon and Operations

When FA-M3 Communication Server is started, it resides in the system and its icon is displayed in the system tray as shown in the figure below.

Right-clicking the icon in the system tray opens a popup menu. From this menu, you can select various functions of FA-M3 Communication Server.

The following table shows the functions available from the menu.

Table 3.6 Functions of FA-M3 Communication Server

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Details</td>
<td>Displays an operation screen of FA-M3 Communication Server. On the operation screen, you can check the settings of all ports and also see the communication status.</td>
</tr>
<tr>
<td>Communications Setup</td>
<td>Allows you to select a port number and set up communications for the port.</td>
</tr>
<tr>
<td>FA-M3 Defender</td>
<td>Starts FA-M3 Defender and allows you to configure security settings for a CPU module that supports security functions.</td>
</tr>
<tr>
<td>Force Exit</td>
<td>Disables all ports currently connected and terminates FA-M3 Communication Server.</td>
</tr>
</tbody>
</table>

B3.4.3 Detailed Setting Screen

The detailed setting screen allows you to check and configure all ports used from FA-M3 Communication Server and also to see the communication status of the ports.

To display the detailed setting screen, use the following procedure.

1. Right-click the FA-M3 Communication Server icon in the system tray, and select [Server Details] from the popup menu.

⇒ The FA-M3 Communication Server dialog box is displayed.
When [FA-M3 Com Server] is selected in the tree, the right pane displays the connection status of each port as shown in the figure below.

Table 3.7 Display Items and Functions of FA-M3 Communication Server

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation Menu</td>
<td>Provides menu items for various functions of FA-M3 Communication Server.</td>
</tr>
<tr>
<td>Port List</td>
<td>Displays a tree view of 16 communication ports.</td>
</tr>
<tr>
<td>Connection Status of Each</td>
<td>Displays the connection status of each port.</td>
</tr>
<tr>
<td>Communication Port</td>
<td>([CPU type]): This communication port is currently connected to the CPU</td>
</tr>
<tr>
<td></td>
<td>module of the indicated type.</td>
</tr>
<tr>
<td></td>
<td>[Unconnected]: This communication port is not connected.</td>
</tr>
<tr>
<td></td>
<td>[Not Set]: Communications setup is not performed for this communication port.</td>
</tr>
</tbody>
</table>

When a port is selected in the tree, the right pane displays the status of the port connected online as shown in the figure below.
Table 3.8 Display Items and Functions of FA-M3 Communication Server

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation Menu</td>
<td>Provides menu items for various functions of FA-M3 Communication Server.</td>
</tr>
<tr>
<td>Port List</td>
<td>Displays a tree view of 16 communication ports.</td>
</tr>
<tr>
<td>Information of the CPU Module to Which the Communication Port Is Connected</td>
<td>Displays the operation information of the CPU module to which the communication port selected from the port list is connected.</td>
</tr>
<tr>
<td>Information of the Application Currently Using the Port</td>
<td>Displays the list of applications that are using the communication port selected from the port list. Also, monitors the connection elapsed time and the sending and receiving status of the application.</td>
</tr>
</tbody>
</table>

**TIP**

While a port is selected on the FA-M3 Communication Server dialog box, if you select [Communications Setup], the Communications Setup dialog box for the port is displayed.

**SEE ALSO**

For details on communications setup in the Communications Setup dialog box, see B3.2, "Connecting and Disconnecting".

**B3.4.4 Communications Setup for Each Port**

The detailed setting screen allows you to check and configure all ports used from FA-M3 Communication Server and also to see the communication status of the ports.

To display the detailed setting screen, use the following procedure.

1. Right-click the FA-M3 Communication Server icon in the system tray, and select [Communications Setup] from the popup menu.

→ The Select Port dialog box is displayed.
2. Select a port for which the communications setup is performed, and click [OK].

⇒ The Communications Setup dialog box is displayed.

SEE ALSO

For details on communications setup in the Communications Setup dialog box, see B3.2, "Connecting and Disconnecting".

B3.4.5 Forced Termination

During communication processing between an FA-M3 application and FA-M3, if an unexpected and unusual failure or problem occurs in the connection processing, FA-M3 Communication Server may become unstable.

When FA-M3 Communication Server is unstable, even if you try to make a reconnection through the same communication port, the online connection may not start correctly.

As a means of recovering from such a situation, FA-M3 Communication Server provides a function for performing a forced termination of a communication port or FA-M3 Communication Server itself.

After the forced termination, the communication processing can be started again from the initial state.

The following describes how to perform each type of forced termination.

CAUTION

Performing a forced termination terminates the ongoing communication processing of an application prematurely even if the processing is being processed properly.

If the application is performing an important online operation (e.g., for changing a program) related to the control of FA-M3, a forced termination may cause an unexpected result in FA-M3.

Do not perform a forced termination if normal communication processing is in progress in any application.
Forced Termination of a Port

To perform a forced termination of a specific port in use, use the following procedure.

1. Open the FA-M3 Communication Server dialog box.

2. In the port list, right-click a port to be terminated, and select [Force Exit This Port] from the right-click menu.
   ⇒ The selected port is terminated.

Forced Termination of FA-M3 Communication Server

To forcibly terminate all ports in use and FA-M3 Communication Server itself, use the following procedure.

1. Right-click the FA-M3 Communication Server icon in the system tray, and select [Force Exit] from the popup menu.
   ⇒ FA-M3 Communication Server is terminated.

   TIP
   You can also perform a forced termination of FA-M3 Communication Server from the menu on the FA-M3 Communication Server dialog box.
B4  Downloading Registered Parameters

This chapter describes how to download registered parameters from PC to FA-M3, as well as how to make comparisons to downloaded data.

- Downloading → B4.1
- Verifying Downloaded Registered Parameters → B4.2

B4.1 Downloading

The download operation stores registered parameters (preset data) created in ToolBox to FA-M3. There are 2 ways to perform downloading: by specifying registered parameters to be downloaded, or by downloading an entire project. There are also 2 options for the download destination: advanced function module or CPU module.

Table B4.1 Types of Downloading

<table>
<thead>
<tr>
<th>Type of Downloading</th>
<th>PC</th>
<th>FA-M3</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module→Module</td>
<td>Registered</td>
<td>Advanced</td>
<td>Writes registered parameters (preset data) created in ToolBox to internal</td>
</tr>
<tr>
<td></td>
<td>parameters</td>
<td>function</td>
<td>registers in advanced function modules of FA-M3.</td>
</tr>
<tr>
<td></td>
<td>of advanced</td>
<td>modules</td>
<td>The two types of downloading differ in that module downloading transfers</td>
</tr>
<tr>
<td></td>
<td>function</td>
<td></td>
<td>data for user-selected modules, while project downloading transfers data</td>
</tr>
<tr>
<td></td>
<td>modules</td>
<td></td>
<td>for all modules.</td>
</tr>
<tr>
<td>Project→Module</td>
<td>Project</td>
<td>Advanced</td>
<td>The two types of downloading differ in that module downloading transfers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>function</td>
<td>data for user-selected modules, while project downloading transfers data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>modules</td>
<td>for all modules.</td>
</tr>
<tr>
<td>Module→CPU</td>
<td>Registered</td>
<td>CPU module</td>
<td>Writes registered parameters (preset data) created in ToolBox to data</td>
</tr>
<tr>
<td></td>
<td>parameters</td>
<td></td>
<td>registers in the CPU Module of FA-M3.</td>
</tr>
<tr>
<td></td>
<td>of advanced</td>
<td></td>
<td>The two types of downloading differ in that module downloading transfers</td>
</tr>
<tr>
<td></td>
<td>function</td>
<td></td>
<td>data for user-selected modules, while project downloading transfers data</td>
</tr>
<tr>
<td></td>
<td>modules</td>
<td></td>
<td>for all modules.</td>
</tr>
<tr>
<td>Project→CPU</td>
<td>Project</td>
<td>CPU module</td>
<td></td>
</tr>
</tbody>
</table>

TIP

- Data stored in the CPU Module is optimized so that it can be effectively used by advanced function modules. When using ladder programs, registered parameters stored in the CPU module can also be transferred directly to the advanced function module. This can be used not only to simplify initialization setup when replacing advanced function modules, but also to backup registered parameter values.
- Downloading changes the CPU operating mode of the CPU module from Run to Stop.
- Downloading registered parameters to advanced function modules may stop the operation of the advanced function module. To restart the operation, switch each advanced function module to Run mode.
B4-2

B4.1.1 Downloading to Individual Modules

The following describes how to download the registered parameters (preset data) of a project into the data/file registers of the advanced function modules or CPU modules installed in FA-M3.

- Downloading to Advanced Function Modules

1. Start ToolBox and select [Online]-[Connect] from the menu bar.

⇒ The Connection Check dialog box is displayed.

2. Select a port to be used for the connection, and click [Connect].

⇒ ToolBox starts the online connection to a CPU module based on the communications setup for the selected port.

SEE ALSO
You can set up the communications for each communication port on the Connection Check dialog box.

For details on the communications setup, see Section B3.2, "Connecting and Disconnecting".


⇒ The Download Module dialog box is displayed.

4. Click the [Select] checkbox for the advanced function module for which data is to be downloaded. Next, click Module.

⇒ If the connected CPU module is in Run mode or Debug mode, a stop confirmation dialog box is displayed.

- Display Colors for downloadable Items

The display colors have the following meanings:
- White:
  Downloading to the module is allowed.
- Red:
  Downloading is not allowed because of a mismatch between the I/O configuration and the file configuration of the module. Verify the configuration of the file or the connected FA-M3 system.
- Yellow:
  The address setup for the CPU module is invalid or not done. Downloading to the CPU module is not allowed but downloading to the module is allowed.
- Gray:
  Not selectable.

5. **Click [Yes]** to switch the CPU operating mode to Stop mode.
⇒ Screen 3 is displayed.

**TIP**
- If some other screen is displayed instead, see: →Section C1.2, “Handling for Special Cases”.
- The actual screen displayed depends on the setup tool used. Screen 3 illustrates the example screen for the ToolBox for Temperature Control and Monitoring Modules.

6. **Select the loops to be downloaded and click [Download]**.
⇒ Downloading to the advanced function module starts. When downloading is completed, the Results of Downloading screen is displayed.

**TIP**
Clicking [Stop] on the Downloading screen aborts the download operation.

**TIP**
The actual messages displayed on the Results of Downloading screen depend on the setup tool used. For details, see the manual provided with the advanced function module.
Downloading to CPU Module

1. Perform online connections in ToolBox.
   
   SEE ALSO
   For details, see steps 1 and 2 in section B4.1.1.

2. Select [Online]-[Download]-[Module] from the menu bar.
   ⇒ The Download Module dialog box is displayed.

3. Click the [Select] checkbox for the advanced function module for which data is to be downloaded. Click [CPU].
   ⇒ If the operating mode of the FA-M3 is in Debug or Run mode, screen 5-1 will be displayed. If the screen is not displayed, proceed to step 5.

   SEE ALSO
   For details on the display colors for downloadable items, see “Display Colors for Downloadable Items” in section B4.1.1.

4. Click [CPU].
   ⇒ If the connected CPU module is in Run mode or Debug mode, a stop confirmation dialog box is displayed.

5. Click [Yes] to switch the CPU operating mode to Stop mode.
   ⇒ The Detailed Setup dialog box is displayed.

   TIP
   - If some other screen is displayed instead, see: →Section C1.2, “Handling for Special Cases”.
   - The actual screen displayed depends on the setup tool used. Screen 6 illustrates the example screen for the ToolBox for Temperature Control and Monitoring Modules.
   - If the data (file) register address has already been specified for the destination CPU in the target registered parameter file, the value will be displayed. You can perform address setup by selecting [Parameter Configuration Definition]-[Detailed Setup].
6. Set up the CPU data (file) registers and ranges to which the parameters are downloaded, and click **Download**.  
⇒ The Download screen is displayed during downloading. When download completes, the Results of Downloading screen is displayed.

**TIP**
Clicking **Stop** on the Download screen aborts the download operation.

**TIP**
The actual messages displayed on the Results of Downloading screen depend on the setup tool used. For details, see the manual provided with the advanced function module.
### Downloading a Project

Downloading project downloads all registered parameters defined in a project.

#### Downloading to Advanced Function Modules

1. Perform online connections in ToolBox.

   **SEE ALSO**
   
   For details, see steps 1 and 2 in section B4.1.1.

2. Select [Online]-[Download]-[Project] from the menu bar.

   ⇒ The Download Project dialog box is displayed.

3. Next, click **Module**.

   ⇒ If the connected CPU module is in Run mode or Debug mode, a stop confirmation dialog box is displayed.

   **SEE ALSO**
   
   For details on the display colors for downloadable items, see “Display Colors for Downloadable Items” in section B4.1.1.

4. Click [Yes] to switch the CPU operating mode to Stop mode and start downloading.

   ⇒ The Download screen is displayed during downloading. When download completes, the Results of Downloading screen is displayed.

   **TIP**
   
   - If some other screen is displayed instead, see: Section C1.2, “Handling for Special Cases”.
   - Clicking **Stop** on the Download screen aborts the download operation.

   **TIP**
   
   The actual messages displayed on the Results of Downloading screen depend on the setup tool used. For details, see the manual provided with the advanced function module.
■ Downloading to CPU Module

1. Perform online connections in ToolBox.

   **SEE ALSO**
   For details, see steps 1 and 2 in section B4.1.1.

2. Select [Online]-[Download]-[Project] from the menu bar.
   ⇒ The Download Project dialog box is displayed.

3. Click **CPU**.
   ⇒ If the connected CPU module is in Run mode or Debug mode, a stop confirmation dialog box is displayed.

   **SEE ALSO**
   For details on the display colors for downloadable items, see “Display Colors for downloadable items” in section B4.1.1.

4. Click **Yes** to switch the CPU operating mode to Stop mode and start downloading.
   ⇒ The Download screen is displayed during downloading. When download completes, the Results of Downloading screen is displayed.

   **TIP**
   - If some other screen is displayed instead, see: →Section C1.2, “Handling for Special Cases”.
   - Clicking **Stop** on the Download screen aborts the download operation.

   **TIP**
   The actual messages displayed on the Results of Downloading screen depend on the setup tool used. For details, see the manual provided with the advanced function module.
B4.2 Verifying Downloaded Registered Parameters

This section describes how to use the compare function to ensure data consistency between data stored in a PC and data stored in the CPU module or advanced function modules of FA-M3.

The term ‘data’ here refers to a project and the registered parameters contained in the project.

Table B4.2 Types of Comparison

<table>
<thead>
<tr>
<th>Type of Comparison</th>
<th>PC</th>
<th>FA-M3</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module and module</td>
<td>Registered parameters of</td>
<td>Advanced function</td>
<td>Compares registered parameters (preset data) created in ToolBox to data in</td>
</tr>
<tr>
<td></td>
<td>advanced function modules</td>
<td>function modules</td>
<td>internal registers of advanced function modules of FA-M3. The two types of</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>comparison differ in that module comparison compares data of user-specified</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>modules, while project comparison compares data of all modules.</td>
</tr>
<tr>
<td>Project and module</td>
<td>Project</td>
<td>Advanced function</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>function modules</td>
<td></td>
</tr>
<tr>
<td>Module and CPU</td>
<td>Registered parameters of</td>
<td>CPU module</td>
<td>Compares registered parameters (preset data) created in ToolBox to data in</td>
</tr>
<tr>
<td></td>
<td>advanced function modules</td>
<td></td>
<td>data registers of the CPU module of FA-M3. The two types of comparison differ</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>in that module comparison compares data of user-specified modules, while</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>project comparison compares data of all modules.</td>
</tr>
<tr>
<td>Project and CPU</td>
<td>Project</td>
<td>CPU module</td>
<td></td>
</tr>
</tbody>
</table>
B4.2.1 Verifying Module Data

### Comparing to Data in Advanced Function Modules

1. Perform online connections in ToolBox.

   **SEE ALSO**
   
   For details, see steps 1 and 2 in section B4.1.1.

2. Select [Online]-[Compare File and Module]-[Module] from the menu bar.

   ⇒ The Compare Module dialog box is displayed.

3. Click the [Select] checkbox for the advanced function module for which data is to be compared.

**Display Colors for Comparable Items**

The display colors have the following meanings:

- **White:**
  
  Comparison to the module is allowed.

- **Red:**
  
  Comparison is not allowed because of a mismatch between the I/O configuration and the file configuration of the module. Verify the configuration of the file or the connected FA-M3 system.

- **Yellow:**
  
  The address setup for the CPU module is invalid or not done. Comparison to the CPU module is not allowed. Comparison to the module is allowed.

- **Gray:**
  
  Not selectable.
4. **Next, click** [Module].
   ⇒ Screen 13 is displayed.

5. **Select the loops to be compared and click** [Compare].
   ⇒ If it is specified that the CPU module refreshes an I/O module, an error may occur during comparison. When such a refreshing operation is specified, a warning message shown in screen 13-1 may be displayed.

   **TIP**
   The actual screen displayed depends on the setup tool used. Screen 13 illustrates the example screen for the ToolBox for Temperature Control and Monitoring Modules.

   **SEE ALSO**
   For details on what to do when other messages are displayed, see:
   → Section B4.2.3, "If Messages are Displayed During Comparison".

6. **To start comparison, click** [Yes].
   ⇒ The comparison screen is displayed during comparison. When comparison completes, the Results of Comparison screen is displayed.

   **TIP**
   Clicking [Stop] on the comparison screen aborts the comparison operation.

   **TIP**
   The actual messages displayed on the Results of Comparison screen depend on the setup tool used. For details, see the manual provided with the advanced function module.
Comparing to Data in CPU Module

1. Perform online connections in ToolBox.

SEE ALSO
For details, see steps 1 and 2 in section B4.1.1.

2. Select [Online]-[Compare File and Module]-[Module] from the menu bar.
⇒ The Compare Module dialog box is displayed.

3. Click the [Select] checkbox for the advanced function module for which data is to be compared.

SEE ALSO
For details on the display colors for items that can be compared, see "● Display Colors for Comparable Items" in section B4.2.1.

4. Click CPU.
⇒ The Detailed Setup dialog box is displayed.

TIP
The actual screen displayed depends on the setup tool used. Screen 16 illustrates the example screen for the ToolBox for Temperature Control and Monitoring Modules.

5. Set up the CPU data (file) registers to be compared, and click Compare.
⇒ If it is specified that the CPU module refreshes an I/O module, an error may occur during comparison. When such a refreshing operation is specified, a warning message shown in screen 16-1 may be displayed.

SEE ALSO
For details on what to do when other messages are displayed, see:
→Section B4.2.3, “If Messages are Displayed During Comparison”.

Screen (16)
6. To start comparison, click [Yes].

⇒ The comparison screen is displayed during comparison. When comparison completes, the Results of Comparison screen is displayed.

TIP
Clicking [Stop] on the comparison screen aborts the comparison operation.

TIP
The actual messages displayed on the Results of Comparison screen depend on the setup tool used. For details, see the manual provided with the advanced function module.
B4.2.2 Verifying Project Data

Comparing to Data in Advanced Function Modules

1. Perform online connections in ToolBox.

SEE ALSO
For details, see steps 1 and 2 in section B4.1.1.

2. Select [Online]-[Compare File and Module]-[Project] from the menu bar.
⇒ The Compare Project dialog box is displayed.

3. Next, click Module.
⇒ If it is specified that the CPU module refreshes an I/O module, an error may occur during comparison. When such a refreshing operation is specified, a warning message shown in screen 18-1 may be displayed.

SEE ALSO
- For details on what to do when other messages are displayed, see: →Section B4.2.3, “If Messages are Displayed During Comparison”.
- For details on the display colors for items that can be compared, see “Display Colors for Comparable Items” in section B4.2.1.

4. To start comparison, click Yes.
⇒ The comparison screen is displayed during comparison. When comparison completes, the Results of Comparison screen is displayed.

TIP
Clicking Stop on the comparison screen aborts the comparison operation.

TIP
The actual messages displayed on the Results of Comparison screen depend on the setup tool used. For details, see the manual provided with the advanced function module.
Comparing to Data in CPU Module

1. Perform online connections in ToolBox.

   SEE ALSO
   For details, see steps 1 and 2 in section B4.1.1.

2. Select [Online]-[Compare File and Module]-[Project] from the menu bar.
   ⇒ The Compare Project dialog box is displayed.

3. Click CPU.
   ⇒ If it is specified that the CPU module refreshes an I/O module, an error may occur during comparison. When such a refreshing operation is specified, a warning message shown in screen 20-1 may be displayed.

   SEE ALSO
   - For details on what to do when other messages are displayed, see: →Section B4.2.3, “If Messages are Displayed During Comparison”.
   - For details on the display colors for items that can be compared, see “● Display Colors for Comparable Items” in section B4.2.1.

4. To start comparison, click Yes.
   ⇒ The comparison screen is displayed during comparison. When comparison completes, the Results of Comparison screen is displayed.

   TIP
   Clicking Stop on the comparison screen aborts the comparison operation.

   TIP
   The actual messages displayed on the Results of Comparison screen depend on the setup tool used. For details, see the manual provided with the advanced function module.
B4.2.3 If Messages are Displayed During Comparison

When using the Compare Function, the following screen may be displayed. It is displayed when data in the CPU module or the advanced function module of the FA-M3 to be compared may be updated (refreshed) during comparison. If this does not pose a problem, click **Yes** to proceed with comparison.

- **Message Description**

  1. **CPU is not in Stop mode.**
     The CPU module is not in Stop mode, and thus, data to be compared may be changed during data comparison.

  2. **Forced set/reset is registered.**
     Forced set or forced reset is registered in the CPU module, and data to be compared may be changed during data comparison.

  3. **Multiple CPUs are installed.**
     Multiple CPU modules are installed, and thus, data to be compared may be changed by a CPU module other than the specified destination CPU module during data comparison.
B5 Adjusting and Checking Online Registered Parameters

This chapter describes how to perform action test on registered parameters downloaded to an advanced function module, and also how to run the action monitor to check on module operation.

- Adjusting Registered Parameters Using Action Test  →  B5.1
- Checking Action Status Using Action Monitor →  B5.2
- Monitoring I/O Relays →  B5.3

ToolBox provides the following functions: action test, action monitor and X/Y I/O relay monitor.
- Action test: adjusts registered parameters of an advanced function module, and changes their preset values.
- Action monitor: checks action status of an advanced function module.
- X/Y I/O relay monitor: monitors ON/OFF status of I/O relays of an advanced function module.

The action test and action monitor run differently for different advanced function modules to achieve optimized adjustment and checking. Combining the action test and action monitor functions will allow you to perform online verification and adjustment of the operation of an advanced function module to achieve the desired result.

TIP
For details on the use of the action test and action monitor that is unique to an individual advanced function module, see the manual provided with the setup tool for the module.
B5.1 Adjusting Registered Parameters Using Action Test

This section describes how to use the action test function to adjust registered parameters downloaded to an advanced function module.

**TIP**

The actual screens and selection buttons displayed depend on the setup tool used.

1. **Start ToolBox and select [Online]-[Connect] from the menu bar.**
   ⇒ The Connection Check dialog box is displayed.

2. **Select a port to be used for the connection, and click [Connect].**
   ⇒ ToolBox starts the online connection to a CPU module based on the communications setup for the selected port.

**SEE ALSO**

You can set up the communications for each communication port on the Connection Check dialog box.

For details on the communications setup, see Section B3.2, "Connecting and Disconnecting".

3. **Select [Debug/Maintenance]-[Action Test] from the menu bar.**
   ⇒ The Select Action Test dialog box is displayed.

4. **Click the slot to be tested on the Select Action Test screen.**

5. **Click the action test function to be performed.**
   ⇒ An action test function screen is displayed for the selected module.

**TIP**

The actual action test function buttons displayed on the screen depend on the setup tool used. Screen 2 illustrates an example for the “tuning function” of ToolBox for Temperature Control and Monitoring Modules.
6. The screens of the action test function depend on the setup tool used. Read this manual together with the manual provided with an individual setup tool.
B5.2 Checking Action Status Using Action Monitor

This section describes how to use the action monitor to test registered parameters downloaded to an advanced function module.

**TIP**
- The actual screens and selection buttons displayed depend on the setup tool used.
- Up to four screens may be displayed using action monitors in Toolbox. Depending on individual setup tools, displaying multiple action monitor screens for the same slot may even be possible.

1. Perform online connection in Toolbox.

   **SEE ALSO**
   See steps 1 and 2 in section B5.1.

2. Select [Debug/Maintenance]-[Action Monitor] from the menu bar.
   ⇒ The Select Action Monitor dialog box is displayed.

3. Select the slot to be monitored and click Action Monitor.
   ⇒ An action monitor function screen is displayed for the selected module.

   **TIP**
The screen display depends on the setup tool used. Screen 5 illustrates an example for [Action Monitor] of ToolBox for Temperature Control and Monitoring Modules.

4. The screens of the action monitor function depend on the setup tools used for advanced function modules. Read this manual together with the manual provided with an individual setup tool.
This section describes how to use the X/Y I/O relay monitor to monitor the ON/OFF status of I/O relays allocated to individual advanced function modules.

**TIP**

- Whether I/O relays are present and the number of I/O relays varies between modules.
- The I/O relay monitor can be used to monitor any module that allows monitoring, regardless of the setup tools currently installed.
- Some advanced function modules are such that modules within the same family have different internal relay maps. To have ToolBox correctly display the I/O relays of these modules, you need to modify ToolBox system files to match the actual modules used using the following procedure:
  1. Using Windows Explorer or other means, open the folder named: "c:\Program Files\Common Files\yokogawa\FAM3\FAM3IODEF". This folder contains I/O relay monitor system files. The filename of each of these systems files (excluding the filename extension) is a four-character string, which represents an advanced function module family. Filename extensions "ini", "sav", "sav1", "sav2" are used to distinguish individual modules within the same family.
  2. Using Notepad or any other generic text editor, you can open the file for the module to be monitored and confirm the model name.
  3. Rename the system file for the module to be monitored by changing its filename extension to "ini". For instance, to monitor a F3LC11-1F module, rename the standard system file named "LC11.sav" to "LC11.ini", which is the system filename actually used by ToolBox. Remember to back up the original file, which is intended for F3LC11-1N and LC11-2N modules.
  4. Run ToolBox.
- The system files used by the I/O relay monitor in ToolBox are shared with the individual FA-M3 support tools so do exercise caution when modifying the files.

1. **Establish an online connection between the PC and FA-M3 using ToolBox.**

   **SEE ALSO**
   For details, see steps 1 and 2 in Section B5.1.

2. **Select [Online]-[X/Y I/O Relay Monitor] from the menu bar.**
   ⇒ The I/O Configuration dialog box is displayed.
3. Select the slot (module name) to be monitored, and click Relay Monitor.
⇒ The X/Y I/O Relay Monitor window (screen 7) is displayed.

**TIP**
You can perform forced set, forced reset and other debugging operations using the X/Y I/O relay monitor.
B6 Uploading Registered Parameters to Computer

This chapter describes how to retrieve registered parameters from advanced function modules and save the data on a computer.

- Uploading Registered Parameters → B6.1
- Writing Registered Parameters to ROM → B6.2

B6.1 Uploading Registered Parameters

The upload function transfers data for registered parameters in the CPU module or advanced function modules of FA-M3 to a computer. The current registered parameter values can be saved to a file.

There are two options for uploading selected registered parameters, namely, from an advanced function module or from a CPU module. Uploading all registered parameters of an entire project, however, can only be performed from advanced function modules.

Table B6.1 Types of Uploading

<table>
<thead>
<tr>
<th>Type of Uploading</th>
<th>FA-M3</th>
<th>PC</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module →Module</td>
<td>Advanced function modules</td>
<td>Registered parameters</td>
<td>Uploads setup data for registered parameters in internal registers of advanced function modules in FA-M3 to the PC.</td>
</tr>
<tr>
<td>Module →Project</td>
<td>Advanced function modules</td>
<td>Project</td>
<td>The two types of uploading differ in that module uploading transfers data for user-selected modules, while project uploading transfers data for all modules.</td>
</tr>
<tr>
<td>CPU →module</td>
<td>CPU module</td>
<td>Registered parameters</td>
<td>Uploads setup data for registered parameters in data (file) registers of CPU module in FA-M3 to the PC.</td>
</tr>
</tbody>
</table>
B6.1.1 Uploading from Individual Modules

This section describes how to select advanced function modules installed in an FA-M3 and upload data.

If a project is open in ToolBox, uploaded data will be added to the project; preset values for registered parameters already existing in the project will be overwritten. If no project is open in ToolBox, a temporary project is created.

TIP

The project will be temporarily saved in the ToolBox work folder after the uploading. To backup the data for subsequent editing, use the “Save Project As” function to save the data to a file.

Uploading from Advanced Function Modules

1. Start ToolBox and select [Online]-[Connect] from the menu bar.
   ⇒ The Connection Check dialog box is displayed.

2. Select a port to be used for the connection, and click [Connect].
   ⇒ ToolBox starts the online connection to a CPU module based on the communications setup for the selected port.

SEE ALSO

You can set up the communications for each communication port on the Connection Check dialog box.
For details on the communications setup, see Section B3.2, “Connecting and Disconnecting”.

   The Upload Module dialog box is displayed.

4. Click the [Select] checkbox for the advanced function module for which data is to be uploaded.

5. Next, click Module.
   ⇒ Screen 3 is displayed.

TIP

The actual screen displayed depends on the setup tool used. Screen 3 illustrates the example screen for the ToolBox for Temperature Control and Monitoring Modules.
Display Colors for Uploadable Items

The display colors have the following meanings:
- White: Uploading is allowed.
- Gray: Not selectable.

6. Select the loops to be uploaded and click **Upload**.

⇒ The Upload screen is displayed during uploading. When upload completes, the Results of Uploading screen is displayed.

**TIP**

Clicking **Stop** on the Upload screen aborts the upload operation.

7. If uploading is successful and a project is open, the uploaded data is added to the project, overwriting values of any registered parameters having the same names. If no project is open, the uploaded data is saved as a temporary project in ToolBox and displayed.

**SEE ALSO**

B6.1.3, “Saving Uploaded Data”
### Uploading from CPU Module

Uploads setup data for registered parameters in data (file) registers of CPU module in FA-M3 as registered parameters of advanced function modules.

If a project is open in ToolBox, uploaded data will be added to the project; preset values for registered parameters already existing in the project will be overwritten. If no project is open in ToolBox, a temporary project is created.

**TIP**  
The project will be temporarily saved in the ToolBox work folder after the uploading. To backup the data for subsequent editing, use the “Save Project As” function to save the data to a file.

1. Perform online connection in ToolBox.

   **SEE ALSO**  
   For details, see steps 1 and 2 in section B6.1.1.

2. Select [Online]-[Upload]-[Module] from the menu bar.  
   ⇒ The Upload Module dialog box is displayed.

3. Click the [Select] checkbox for the advanced function module for which data is to be uploaded.  
   Click CPU.  
   ⇒ The Detailed Setup dialog box is displayed.

   **TIP**  
The actual screen displayed depends on the setup tool used. Screen 6 illustrates an example for the ToolBox for Temperature Control and Monitoring Modules.

   **SEE ALSO**  
   For details on the display colors for uploadable items, see “● Display Colors for Uploadable Items” in section B6.1.1.
4. Complete data entry on the screen and click [Upload].
⇒ The Upload screen is displayed during uploading. When upload completes, the Results of Uploading screen is displayed.

**TIP**
Clicking [Stop] on the Upload screen aborts the upload operation.

5. If uploading is successful and a project is open, the uploaded data is added to the project, overwriting values of any registered parameters having the same names. If no project is open, the uploaded data is saved as a temporary project in ToolBox and displayed.

**SEE ALSO**
B6.1.3, “Saving Uploaded Data”

**Screen (6)**

**Screen (7)**
B6.1.2 Uploading a Project

Uploading a project uploads module configuration installed in FA-M3 as a project. A temporary project is created.

**TIP**

The project will be temporarily saved in the ToolBox work folder after the uploading. To backup the data for subsequent editing, use the “Save Project As” function to save the data to a file.

### Uploading

1. Perform online connection in ToolBox.

   **SEE ALSO**

   For details, see steps 1 and 2 in section B6.1.1.

2. Select [Online]-[Upload]-[Project] from the menu bar.

   ⇒ The Upload Project dialog box is displayed.

3. Click OK.

   ⇒ The Upload screen is displayed during uploading. When upload completes, the Results of Uploading screen is displayed.

   **TIP**

   - If a project is open before uploading, a message is displayed to confirm whether to proceed with closing the project.
   - Clicking Stop on the Upload screen aborts the upload operation.

4. If uploading is successful, the uploaded data is saved as a temporary project in ToolBox and displayed.

   **SEE ALSO**

   B6.1.3, “Saving Uploaded Data”
B6.1.3 Saving Uploaded Data

You should save the temporary project file containing uploaded data. Performing some other operation without saving the data will display a screen prompting you to save the data.

■ Saving A Project to A New File

1. Click [File]-[Save Project As] from the menu bar.
   ⇒ The Saves Project As dialog box is displayed.

2. Enter a new project name and click Save.

■ Saving a Project by Overwriting Data in an Existing File

1. Click [File]-[Save Project As] or [Save Project] from the menu bar.
   ⇒ The Saves Project As dialog box is displayed.

2. Click the project folder and click Save.
   ⇒ Screen 12 is displayed.

3. Click the project file and click Save.
   ⇒ Screen 12-1 is displayed.
4. If you have selected a different project, a dialog box will be displayed to confirm whether to proceed with overwriting. Click [Yes].

⇒ The data is overwritten.

Executing Other Operations without First Saving Data

1. When executing any of the following operations without first saving project data,
   - Exiting from ToolBox
   - Exiting from project
   - Creating a new project
   - Opening a project
   - Uploading a project again
   - Creating new registered parameter files
   - Modifying the parameter configuration definition
   - Changing CPU type/properties
   - Adding, deleting or renaming registered parameter files

⇒ Screen 12-2 is displayed.

2. Click [Yes].

   Follow the procedure described in “Saving A Project to A New File”

Screen (12-2)

TIP

Temporary saved projects are saved as files in the ToolBox work folder. If the projects are not saved permanently using ToolBox save operations, they will accumulate in the work folder. Since data in the work folder cannot be reused, these files are normally redundant.

To ensure sufficient hard disk space, we recommend that you delete redundant files in the work folder periodically by selecting [Tools]–[Empty Work Folder] from the menu bar.
B6.2 Writing Registered Parameters to ROM

This section describes how to save registered parameters to the internal ROM.

TIP
Some advanced function modules do not support writing to an internal ROM.

Writing to Internal ROM

1. While connected online, select [Online]-[Module ROM Management]-[File→ROM Transfer] from the menu bar.
⇒ The File→ROM Transfer dialog box is displayed.

2. Click the checkbox in the Select Column for the modules for which data is to be downloaded.

   TIP
   You may select multiple modules.

3. Click OK.
⇒ If the connected CPU module is in Run mode or Debug mode, a stop confirmation dialog box is displayed.

4. Clicking Yes terminates Run mode and starts writing to the internal ROM.

   TIP
   - If some other screen is displayed instead, see: →Section C1.2, “Handling for Special Cases”.

5. After transfer from file to ROM completes, click OK.
6. Follow the same procedure for Module to ROM transfer.
⇒ The Module→ROM Transfer dialog box is displayed.
After that, follow steps 2 to 5.

TIP
- The Module to ROM transfer function transfers data in the module memory to ROM.
- For some modules, the download operation also transfers data to the ROM.

Reverting to Factory ROM Settings

⇒ The Initialize ROM dialog box is displayed.

2. Click the checkbox in the Select Column for the modules for which the internal ROM is to be initialized.

TIP
You may select multiple modules.

3. Click OK.
⇒ If the connected CPU module is in Run mode or Debug mode, a stop confirmation dialog box is displayed.

4. Clicking Yes terminates Run mode and starts initialization of the internal ROM.

TIP
- If some other screen is displayed instead, see: →Section C1.2, “Handling for Special Cases”.

5. After initialization completes, click OK.
B7 Printing and Using Created Data
This chapter describes how to print and export create data.

- Printing Created Data → B7.1
- Using Created Data → B7.2

B7.1 Printing Created Data
Before printing, check that a printer is properly connected to the PC.

B7.1.1 Printing
Parameters not registered in the parameter configuration definition cannot be printed or previewed using the Print Project function.

Print Screen
You can print the contents of a Registered Parameters window (not available when using FA-M3 ToolBox for Temperature Control and Monitoring Modules).

1. Make the Registered Parameters window to be printed the active window.

2. Click [File]-[Print]-[Screen] from the menu bar.
   ⇒ The Print Screen dialog box is displayed.

3. Check the print setup, and then check the print results by clicking Preview.
   - To change the page setup, proceed to: "Page Setup" in Section B7.1.2, "Print Setup"
   - To change the printer setup, proceed to:
     "Printer Setup" in Section B7.1.2, "Print Setup"
   - To preview print results, proceed to:
     "Preview" in Section B7.1.2, "Print Setup"

4. Perform detailed setup and specify the print range on the Print Screen, and click Print.
   ⇒ Printing begins.
5. The following information is printed, as shown in Printout 2:
   - File name
   - Title
   - Module type

### Print Project

1. Open the project to be printed.

2. Click [File]-[Print]-[Project] from the menu bar.
   ⇒ The Print Project dialog box is displayed.

3. Check the print setup, and then check the print results by clicking Preview.
   - To change the page setup, proceed to: “Page Setup” in Section B7.1.2, “Print Setup”
   - To change the printer setup, proceed to: “Printer Setup” in Section B7.1.2, “Print Setup”
   - To preview print results, proceed to: “Preview” in Section B7.1.2, “Print Setup”

4. Perform detailed setup and specify the print range on the Print Project screen, and click Print.
   ⇒ Printing begins.

**TIP**
To print some but not all modules, click Some modules followed by Browse to select the required registered parameter files.
5. The following information is printed, as shown in Printout 4:

- Project name
- Title
- CPU Module type
- Last modified date
- File name
- Title
- Module type

### Printout (4)

<table>
<thead>
<tr>
<th>File Name</th>
<th>Date</th>
<th>Size</th>
<th>VSH</th>
<th>VSG</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printout 4</td>
<td>04/26/2013</td>
<td>123 KB</td>
<td>456</td>
<td>789</td>
</tr>
</tbody>
</table>
B7.1.2 Print Setup

■ Preview

1. Open the project to be printed.

2. Click [File]-[Print Preview]-[Registered Parameters] or [File]-[Print Preview]-[Project] from the menu bar.

⇒ Print Preview Screen 5 is displayed.

TIP

Clicking [Preview] on the Print Project dialog box will also display the preview screen.

Operations on the Print Preview Screen

The following operations are available from the toolbar on the Print Preview Screen.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Starts printing.</td>
</tr>
<tr>
<td>Next Page</td>
<td>Displays the print preview image of the next page.</td>
</tr>
<tr>
<td>Previous Page</td>
<td>Displays the print preview image of the previous page.</td>
</tr>
<tr>
<td>Two Pages</td>
<td>Switches between displaying the print image for one or two pages at a time.</td>
</tr>
<tr>
<td>Zoom Up</td>
<td>Enlarges the image on the display in two steps.</td>
</tr>
<tr>
<td>Zoom Down</td>
<td>Reduces the image on the display.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the print preview window.</td>
</tr>
</tbody>
</table>
Clicking **Page Setup** on the Print window allows you to set the paper orientation and margins, edit the header, footer and cover and perform other page setup.

- **Page Setup**

(a) [Page Setup] tab
(b) Size
(c) Orientation
(d) Margins
(e) Format
(f) Print Position
(g) Initial Value
(h) **OK** button
(i) **Cancel** button
(j) **Help** button

- **Page Setup**

(a) Selects page for page setup.
(b) Displays paper size.
(c) Displays paper orientation.
(d) Enter any value between 0 to 30 (mm) for the top, bottom, left and right margins. You can also set the values using the spin buttons.
(e) Select No Page Number, Sequential Number, or Sectional Number for the page number format.
(f) Select Left, Center or Right for the print position of the page number.
(g) Enter a value from 1 to 100 for the first page number. You can also set the value using the spin button.
(h) Updates page setup.
(i) Discards page setup changes.
(j) Displays help information for ToolBox.
● Header/Footer

(a) [Header/ Footer] tab  Select tab screen for header and footer setup.

(b) Edit Header  Area for editing header.
- Height: up to 8 lines can be defined.
- Width: up to 108 characters can be defined.

(c) Edit Footer  Area for editing footer.
- Height: up to 8 lines can be defined.
- Width: up to 108 characters can be defined.

(d) OK button  Updates page setup.

(e) Cancel button  Discards page setup changes.

(f) Help button  Displays help information for ToolBox.
**Cover**

(a) **[Cover] tab** Select the tab screen for cover setup.

(b) **Edit Cover** Area for editing cover.
   - Height: up to 16 lines can be defined.
   - Width: up to 64 characters can be defined.

(c) **OK button** Updates page setup.

(d) **Cancel button** Discards page setup changes.

(e) **Help button** Displays help information for ToolBox.
Printer Setup

Clicking the Printer Setup button on the Print screen allows you to set the printer to be used, paper size, print orientation and perform other printer setup.

- **Printer name**: Select the printer to be used from the list of printers defined in the computer. The printer last used is selected by default.
- **Properties button**: Displays properties dialog for the printer selected in (a). This allows detailed printer setup. The actual display depends on individual printers.
- **Printer information**: Displays information (status, type, location, comment) about the printer selected in (a).
- **Size**: Select the paper size to be used from a list of paper sizes registered for the printer selected in (a). By default, the previous setup value is selected.
- **Source**: Select the paper source to be used from a list of paper sources registered for the printer selected in (a). By default, the previous setup value is selected.
- **Orientation**: Selects the print orientation as Portrait or Landscape. By default, the previous setup value is selected.
- **Network button**: Select the printer to be used from a list of printers connected to the network.
- **OK button**: Updates printer setup.
- **Cancel button**: Discards printer setup changes.
B7.2 Using Created Data

This section describes how to save registered parameter file information contained in a project to an external file in CSV format. This allows the data to be used by Microsoft Excel (hereinafter abbreviated as Excel) and other software applications.

1. Open the required project.

2. Click [File]-[Export] from the menu bar.
   ⇒ The Export Parameters dialog box is displayed.

3. Click the checkbox in the Select Column for the file to be saved.

4. Next, click Export.
   ⇒ Screen 7 is displayed.

5. Enter a name for the destination file.
   TIP
   The full pathname of the destination file name (that is, including the folder name) can be up to 254 characters.

6. Click Save.
   ⇒ The data is saved to a file in CSV format.

   TIP
   - By default, the destination file is saved in the same folder containing the current open project.
   - You can display the content of the destination file by double-clicking the file name in windows Explorer on a PC with Excel installed.
C1 Useful Technical Information

This chapter describes the meaning of various warnings that may be displayed when using ToolBox, handling required for special cases, limitations and the menu bar displayed on the operation screen.

- Warnings → C1.1
- Handling for Special Cases → C1.2
- Limitations → C1.3
- Menu Bar Overview → C1.4

C1.1 Warnings

If a problem is encountered in ToolBox, a screen similar to the following screen will be displayed. Deal with the problem, using the possible causes and suggested remedies displayed on the screen to help you.

![Warning Screen Example]

- Warning
- Cause
- Remedy
C1.2 Handling for Special Cases

When invoking downloading, ROM transfer or other functions, a message may be displayed for confirmation to proceed. If you think it is fine to proceed with the operation, click Yes.

Depending on the status of FA-M3, data in the module may be overwritten (refreshed) during the execution of such function. In such situations, a message is displayed to warn that writing parameters directly to the advanced function module may result in incorrect values.

These display messages and their possible causes are listed below.

- **Releasing forced set/reset on the CPU. Continue?**
  Forced set/reset has been registered in the CPU module. Depending on the operation state, data may be modified, or writing to the advanced function module may fail.

- **Another CPU is detected. Refreshing by this CPU may cause errors during *****. Start *****?**
  Multiple CPU modules are running. Hence, data in the advanced function module may be overwritten (refreshed) by a CPU module other than the destination CPU module.

- **CPU is in ROM Writer mode.**
  Downloading is not allowed when the CPU operating mode of the CPU module is in ROM Writer mode. Exit from ROM Writer mode using WideField3 or some other means.

C1.2.1 Downloading

The same screens are displayed, whether downloading to advanced function modules or CPU modules.

- **When the CPU operating mode of the CPU module is in ROM Writer mode:**

- **When forced set/reset is registered in the CPU module:**

- **When multiple CPU modules are installed:**
C1.2.2 ROM Transfer
The same screens are displayed, whether transferring from file or advanced function module.

- When forced set/reset is registered on the CPU module:

- When multiple CPU modules are installed:

C1.2.3 ROM Initialization
- When forced set/reset is registered in the CPU module:

- When multiple CPU modules are installed:
## C1.3 Limitations

### C1.3.1 Limitations of ToolBox

- **Only one project may be open.**
  
  Only one project may be open at any one time in one ToolBox instance. To open another project, close the current open project.

- **The same project cannot be opened concurrently.**
  
  The same project cannot be opened concurrently in different ToolBox instances. Any attempt to do so will display the following message: “Project is already opened in another ToolBox application.”

- **Up to two ToolBox instances may be running concurrently.**
  
  - Up to two ToolBox instances may be running concurrently. If you attempt to start the third ToolBox, startup will fail with the following displayed message: “Unable to start ToolBox because too many Toolbox applications are already running concurrently.”

- **There are limitations on the second and subsequent ToolBox instances.**
  
  - The second and subsequent ToolBox instances run as Auxiliary ToolBox instances. While an Auxiliary ToolBox is running, all new ToolBox instances will be started as Auxiliary ToolBox instances.
  
  - To start a non-Auxiliary ToolBox instance, which has no execution limitations, exit from all Auxiliary ToolBox instances before starting ToolBox.
  
  - The [Tools] menu is disabled in the second and subsequent ToolBox instances.
  
  - In the second and subsequent ToolBox instances, the following functions cannot be used: download, upload, compare file and module, module ROM management and action test. The action monitor can be used.

- **When running other tools concurrently with ToolBox**
  
  When other tools are running and performing online operations concurrently with ToolBox, action test or uploading may fail because of communications overload.

- **When data of an advanced function module is modified by applications other than ToolBox**
  
  When data of an advanced function module is changed by WideField3 or a ladder program, adjustments to registered parameters made in ToolBox may be overwritten and hence not reflected.

- **Up to 128 registered parameter files may be created in one project**

- **ToolBox cannot be used for continuous operations in a production environment**
  
  ToolBox is a tool for setting up parameters of FA-M3 advanced function modules. Its control and operation functions cannot be used for continuous operations in a production environment.

### C1.3.2 Limitations Across Modules

- **When multiple advanced function modules are started using setup tool**
  
  When multiple advanced function modules are started using a setup tool, some of the functions of the advanced function modules may become unusable.
# C1.4 Menu Bar Overview

## C1.4.1 Menu Description

<table>
<thead>
<tr>
<th>No</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>New Project</td>
<td>Creates a new project.</td>
</tr>
<tr>
<td>2</td>
<td>Open Project</td>
<td>Opens an existing project.</td>
</tr>
<tr>
<td>3</td>
<td>Close Project</td>
<td>Closes an open project.</td>
</tr>
<tr>
<td>4</td>
<td>Save Project</td>
<td>Saves an open project to a file.</td>
</tr>
<tr>
<td>5</td>
<td>Save Project As</td>
<td>Saves an open project to a file with a specified name.</td>
</tr>
<tr>
<td>6</td>
<td>New</td>
<td>Creates a new registered parameter file for an advanced function module.</td>
</tr>
<tr>
<td>7</td>
<td>Open</td>
<td>Opens a registered parameter file of an advanced function module in an edit window.</td>
</tr>
<tr>
<td>8</td>
<td>Close</td>
<td>Closes a registered parameter file of an advanced function module being edited.</td>
</tr>
<tr>
<td>9</td>
<td>Save</td>
<td>Saves a registered parameter file of an advanced function module being edited to a file.</td>
</tr>
<tr>
<td>10</td>
<td>Save As</td>
<td>Saves a registered parameter file of an advanced function module being edited to a file with a specified filename.</td>
</tr>
<tr>
<td>11</td>
<td>Export</td>
<td>Saves content of selected registered parameter file(s) in a project to a file in CSV format.</td>
</tr>
<tr>
<td>12</td>
<td>Printer Setup</td>
<td>Performs environment setup for printer to be used by Toolbox.</td>
</tr>
<tr>
<td>13</td>
<td>Print Preview</td>
<td>Displays on screen a print result preview for project printing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Displays on screen a print result preview for various types of screens.</td>
</tr>
<tr>
<td>14</td>
<td>Print</td>
<td>Prints a project.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Prints various types of screens.</td>
</tr>
<tr>
<td>15</td>
<td>History</td>
<td>Opens a project file by selecting from a list of recently opened projects.</td>
</tr>
<tr>
<td>16</td>
<td>Exit</td>
<td>Exits from Toolbox.</td>
</tr>
</tbody>
</table>

### Edit

<table>
<thead>
<tr>
<th>No</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Undo</td>
<td>Undoes the most recent edit operation and reverts to the previous state during editing of registered parameters on an edit screen.</td>
</tr>
<tr>
<td>2</td>
<td>Redo</td>
<td>Redoes the most recent edit operation that was undone during editing of registered parameters on an edit screen.</td>
</tr>
<tr>
<td>3</td>
<td>Update</td>
<td>Confirms and saves edit screens with modified parameters during editing of registered parameters on an edit screen.</td>
</tr>
<tr>
<td>4</td>
<td>Cut</td>
<td>Moves the content of the selection on an edit screen to the clipboard.</td>
</tr>
<tr>
<td>5</td>
<td>Copy</td>
<td>Copies the content of the selection on an edit screen to the clipboard.</td>
</tr>
<tr>
<td>6</td>
<td>Paste</td>
<td>Inserts the content on the clipboard at a specified location on an edit screen.</td>
</tr>
<tr>
<td>7</td>
<td>Delete</td>
<td>Deletes the content of the selection on an edit screen.</td>
</tr>
<tr>
<td>8</td>
<td>Set Default Value</td>
<td>Sets the selected edit cells on an edit screen to default values.</td>
</tr>
<tr>
<td>9</td>
<td>Set to Maximum Value</td>
<td>Sets the selected edit cells on an edit screen to maximum values.</td>
</tr>
<tr>
<td>10</td>
<td>Set to Minimum Value</td>
<td>Sets the selected edit cells on an edit screen to minimum values.</td>
</tr>
<tr>
<td>11</td>
<td>Properties</td>
<td>Displays information about a user registered parameter file in a dialog window.</td>
</tr>
</tbody>
</table>

### Project

<table>
<thead>
<tr>
<th>No</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Parameter Configuration Definition</td>
<td>Builds parameter file configuration for a group of advanced function modules of the destination CPU in a project.</td>
</tr>
<tr>
<td>2</td>
<td>Change CPU Type/Properties</td>
<td>Changes the CPU type or project title for a project.</td>
</tr>
<tr>
<td>3</td>
<td>Insert File</td>
<td>Retrieves an existing registered parameter file and imports it into the project.</td>
</tr>
<tr>
<td>4</td>
<td>Rename File</td>
<td>Changes the name of an existing registered parameter data file.</td>
</tr>
<tr>
<td>5</td>
<td>Delete File</td>
<td>Deletes a registered file from a project.</td>
</tr>
<tr>
<td>6</td>
<td>Change Module Type</td>
<td>Changes the module type specified in a registered parameter file.</td>
</tr>
</tbody>
</table>

### View

<table>
<thead>
<tr>
<th>No</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Show</td>
<td>Shows all hidden columns in an edit screen.</td>
</tr>
<tr>
<td>2</td>
<td>Hide</td>
<td>Hides the selected column on an edit screen.</td>
</tr>
<tr>
<td>3</td>
<td>Toolbars</td>
<td>Shows or hides the standard toolbar.</td>
</tr>
<tr>
<td></td>
<td>Standard</td>
<td>Shows or hides the standard toolbar.</td>
</tr>
<tr>
<td></td>
<td>Online</td>
<td>Shows or hides the online toolbar.</td>
</tr>
<tr>
<td>4</td>
<td>Window List</td>
<td>Shows or hides the Window List toolbar.</td>
</tr>
<tr>
<td>5</td>
<td>Status Bar</td>
<td>Shows or hides the status bar.</td>
</tr>
<tr>
<td>6</td>
<td>Project Window</td>
<td>Shows or hides the project window.</td>
</tr>
<tr>
<td>7</td>
<td>Debugger Window</td>
<td>Shows or hides the debugger window.</td>
</tr>
<tr>
<td>8</td>
<td>Action Status Bar</td>
<td>Shows or hides the action status bar.</td>
</tr>
<tr>
<td>9</td>
<td>Redisplay</td>
<td>Refreshes display of the active window.</td>
</tr>
<tr>
<td></td>
<td>Online</td>
<td>Debug/Maintenance</td>
</tr>
<tr>
<td>---</td>
<td>-----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1</td>
<td>Connect</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Connects ToolBox and FA-M3 System. Connection is performed using</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the communications medium specified in the communications setup</td>
<td></td>
</tr>
<tr>
<td></td>
<td>using [Tools]-[Environment Setup].</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Disconnect</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disconnects ToolBox and FA-M3 System</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>X/Y I/O Relay Monitor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Monitors X/Y input/output relays of the CPU.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CPU Operating Mode</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Changes the CPU operating mode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Run</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Changes the CPU operating mode to Run mode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stop</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Changes the CPU operating mode to Stop mode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Debug</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Changes the CPU operating mode to Debug mode.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Download</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transfers registered parameters to FA-M3.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Project</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transfers all parameters defined in the project configuration to FA-M3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Module</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transfers parameters for specified modules from a project to FA-M3.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Upload</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transfers data in FA-M3 to a PC.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Project</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reads parameter data for all modules from the FA-M3 and saves it in</td>
<td></td>
</tr>
<tr>
<td></td>
<td>a ToolBox project.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Module</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reads parameter data for a specified module from the FA-M3, and</td>
<td></td>
</tr>
<tr>
<td></td>
<td>saves it in a registered parameter file.</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Compare File and Module</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Compares the values of registered parameters in a project against</td>
<td></td>
</tr>
<tr>
<td></td>
<td>values in the destination FA-M3 and displays the results in a window.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Project</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Compares the values of all registered parameters in a project against</td>
<td></td>
</tr>
<tr>
<td></td>
<td>values in the destination FA-M3 and displays the results in a window.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Module</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Compares the values of registered parameters for specified modules in</td>
<td></td>
</tr>
<tr>
<td></td>
<td>a project against values in the destination FA-M3 and displays the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>results in a window.</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Module ROM Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Manages ROM.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>File-&gt;ROM Transfer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transfers a registered parameter file to the ROM.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Module-&gt;ROM Transfer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transfers preset values in a module to the ROM.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Initialize ROM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Initializes ROM of selected modules.</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Suspend/Restart Monitoring</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Suspends or restarts updating of various monitor screens.</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Temporarily Change Communication Speed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Changes communication speed when connecting to CPU module using RS-232</td>
<td></td>
</tr>
<tr>
<td></td>
<td>communication.</td>
<td></td>
</tr>
</tbody>
</table>

**Debug/Maintenance**

1. Action Test
   - During online operation, controls action of an advanced function module by writing data to the registers in the module.

2. Action Monitor
   - Reads register information from advanced function modules and displays the information on the screen.

**Tools**

1. Environment Setup for ToolBox
   - Sets up the operating environment for ToolBox.

2. Font
   - Selects font for characters displayed on screens.

3. Environment Setup for advanced function module 1
   - Sets up the operating environment for installed toolbox components.
   - e.g. Environment Setup for Temperature Monitoring and Control Module

4. FA-M3Defender
   - Starts the security setup software for CPU modules that support security functions.

5. Empty Work Folder
   - Deletes all files in work folder.

**Window**

1. Arrange
   - Arranges sub-windows open in ToolBox in the display.
   - Tile Vertically: Tiles windows vertically in the display.
   - Tile Horizontally: Tiles windows horizontally in the display.
   - Cascade: Cascades windows in the display.

2. Arrange Icons
   - Arranges iconized windows in the display of ToolBox.

3. List of windows
   - Displays a list of sub-windows opened in ToolBox.
   - Makes the selected window the active window.

**Help**

1. Help
   - ToolBox Help: Displays help information for ToolBox.
   - ToolBox for advanced function module 1: The names of installed toolbox components are displayed.
   - Example: ToolBox for Temperature Control and Monitoring Module

2. About ToolBox
   - Displays version information about ToolBox.
Index

A
action monitor .................................................. B5-1,B5-4
action status bar ............................................. B1-4
action test ......................................................... B5-1,B5-2
advanced function module.............................. A1-1,B4-1,B6-2
applicable product ............................................. I
B
basic keys ......................................................................... B1-7
C
command list .......................................................... B1-6
component files .................................................... B1-10
communications setup overview ...................... B3-4
communications setup ........................................ B3-3
configuration definition ..................................... B3-23
connecting ToolBox and FA-M3 system ............. A2-11
connections, setting up (communications setup) B3-1
cover, edit ............................................................. B7-7
CPU module .......................................................... B2-3,B6-4
CPU operating mode .............................................. B1-4,B4-3
CPU register ......................................................... B3-24
CSV format .......................................................... B7-9
D
Debugger window ................................................. B1-2
default folder name .............................................. B1-11
delete file ............................................................ B2-7
disconnecting ......................................................... B3-19
display colors for downloadable items ............. B4-2
display colors for uploadable items ................. B6-3
download ............................................................. B4-1
E
Empty Work Folder .............................................. B6-8
environment setup ............................................. B1-11
Ethernet ............................................................ A2-2,B3-1,B3-8
export ............................................................... B7-9
F
FL-net ............................................................... A2-2,B3-1,B3-11
folder setup .......................................................... B1-11
folder structure .................................................... B1-9
functions available in ToolBox ......................... A2-10
H
header/footer ....................................................... B7-6
how to read this manual ........................................ viii
I
icon ................................................................................. B1-10
Important ....................................................................... ii
I/O configuration ................................................... B3-23
I/O relay monitor ................................................. B5-5
insert file ............................................................. B2-6
install ................................................................. A2-3
installation configuration .................................. B3-24
internal ROM ....................................................... B6-9
L
local node setup ..................................................... B3-21
M
menu bar overview ............................................... C1-5
menu bar ............................................................. B1-2
menu layout ......................................................... B1-6
modem ............................................................... B3-17
N
network card, specify .......................................... B3-21
node number, specify ......................................... B3-21
notation ............................................................... viii
O
online connection ................................................ B3-5
operating environment ...................................... A2-2,B1-11
operation commands ......................................... B1-7
operation screen ................................................ B1-1
other instruction manuals ................................... ix
P
page setup ........................................................... B7-5
preview .............................................................. B7-4
print ................................................................... B7-1
print setup .......................................................... B7-4
printer setup ......................................................... B7-8
procedure for using ToolBox ........................... A2-1
project ............................................................... B2-1
projects, modifying existing ............................. B2-5
projects, saving by overwriting ......................... B6-7
projects, saving to new file ............................... B6-7
project file structure ........................................... B1-10
Project window .................................................. B1-2
R
register .............................................................. B3-24
registered parameter ........................................ B2-1
registered parameters, creating and editing ........ B2-4
registered parameters, verifying ....................... B4-8
rename file ......................................................... B2-6
ROM, writing to .................................................. B6-9
ROM initialization ............................................... B6-10
RS-232C ............................................................ A2-2,B3-1,B3-7

Index-2

S
saving uploaded data ........................................B6-7
screen layout .....................................................B1-1
setup tool ...........................................................viii
shortcut keys .....................................................B1-8
slot ...................................................................B3-23
start/terminate ....................................................A2-9
status bar ...........................................................B1-5
system configuration setup ..............................B3-23

T
temporarily changing communication speed ...B3-20
temporary saved projects ....................................B6-8
title bar ..............................................................B1-2
toolbar ..............................................................B1-3
toolbar setup ....................................................B1-12

U
uninstall .............................................................A2-6
upload .............................................................B6-1
USB ..................................................A2-2,B3-1,B3-5
USB driver .........................................................A2-8

V
verifying .............................................................B4-8

W
warning ..............................................................C1-1
work folder ........................................................B6-2

X
X, Y relay ...........................................................B5-5
## Revision Information

**Document Name**: FA-M3 ToolBox Manual  
**Document No.**: IM 34M06Q30-01E

<table>
<thead>
<tr>
<th>Edition</th>
<th>Date</th>
<th>Revised Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st</td>
<td>Mar. 2004</td>
<td>New publication</td>
</tr>
<tr>
<td>2nd</td>
<td>Feb. 2005</td>
<td>Added documentation for ToolBox for Positioning (for F3NC32/34) Module</td>
</tr>
<tr>
<td>3rd</td>
<td>Jul. 2007</td>
<td>Added documentation for USB communication support</td>
</tr>
<tr>
<td>4th</td>
<td>Jul. 2011</td>
<td>Added documentation for F3SP71-4N,F3SP76-7N support</td>
</tr>
<tr>
<td>5th</td>
<td>Jan. 2012</td>
<td>Added documentation for ToolBox for Positioning (for F3NC32/34) and Temperature Control Modules</td>
</tr>
<tr>
<td>6th</td>
<td>Sep. 2012</td>
<td>Added documentation for ToolBox for Positioning (for F3NC32/34) and Temperature Control Modules</td>
</tr>
<tr>
<td>7th</td>
<td>Apr. 2013</td>
<td>Added documentation for ToolBox for Positioning (for F3YP22/24/28) Modules</td>
</tr>
</tbody>
</table>

Written by: PLC Product Development & Engineering Department  
Control Instruments Business Division  
IA Platform Business Headquarters  
Yokogawa Electric Corporation

Published by: Yokogawa Electric Corporation  
2-9-32 Nakacho, Musashino-shi, Tokyo, 180-8750, JAPAN

Printed by: Kohoku Publishing & Printing Inc.